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1.0

MBI-100

EXAMINATION OF BLOODSTAINED EVIDENCE

BACKGROUND :

Examination of items of evidence for the presence and
identification of human bloocd is routinely perfongﬁd in
Forensic Biology using visual examination, preigﬁptzve
gcreening and confirmatory testing for 1dent;§& tion of
blood and determination of the species of

Forengic Science Handbook, Chapter 7: T tification and

Grouping of Bloodstains, pp.267-337, ntice-Hall, 1982,

Sourcebook in Forensic Serology, /I@§unq#§§ and Biochemisgtry

U.S. Department of Justice, NIJ

@ 98{p‘“§ 133.

Cox, M. A Study of the Senskg}v1 ecificity of Four
Presumptive Tests for Blo @y éi, Forensic Sciencesg,
September 1991; 36(5): 4\@3 &

0
S @ @0
2.0 SCOPE: Q O A
W\
To provide unssg? cefﬁing of evidentiary material for
the presenceo S %
3.0 EQﬂIPMEMEAGENT Q)
Vari$§g lighting conditions, including IR, and
fication may be used in general evidence examination
to enhance the obgervation of blococd. Reagents for blood
detection and identification are listed in the appropriate
processing protocols.
4,0 PROCEDURE:
See Flow Chart on following page.
Cagework Analytical Methods: MBI-100 Revision 12
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RECEIPT & DOCUMENTATION
OF EVIDENCE AND PACKAGING

l

VISUAL EXAMINATION
(USE OF LIGHTING, IR, AND
MAGNIFICATION AS
WARRANTED) BI-111

/

N

NO BLOOD DETECTED

NO

ECTED
BLO ATNS LOCATED

‘

&

*

NEGATIVE

4
PRESUMPTIVE SCREENING
{ PHENOLPHTHALEIN or O-TOL)

BI-104, BI-105

Q
\Q

SUSP

"o~ &

3
D)
I5 NON- Hi}%@XBLOCE) E&

v

POSITIVE

SPECIES DETERMINATION

{ABAcard HemaTrace, Ouchterlony

or Real Time PCR)

S

A
REVIEW & RE PO%@

s\&c}x & BI-106, BI-108; BI-207
ENINZ o }
%()-—-—-— NEGATIVE POSITIVE

!

RESULTS O P
EXAMINATIONS ENCY | ©

¥

5.0 COMMENTS:

5.1 In determination of species,

HUMAN BILOOD INDICATED
TO DNA ANALYSIS AS APPROPRIATE

the amount and condition

of the stain should be considered in reporting a
negative determination.

Digcretion should be used in testing small and or poor

condition samples for species determination if DNA
testing is necessary.

Casework Analytical Methods:
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MBI-102

EXAMINATION OF EVIDENCE FOR SEMEN

1.0 BACKGROUND: ()

%]

Examination of items of evidence for the preg&rce and
identification of human semen is routinel rformed in
Forensic Biology using visual examinatio&%}presumptive
screening and confirmatory testing for‘éﬁ@ntification.

Sourcebook in Forensic Serology, I ol and Biochemistry
U.S. Department of Justice, NIJ,<?3B1:¥> {2;181.

2.0 SCOPE: %) e
= \CJ @

To provide uniform proces&%ng Qg§e<f§§ tiary material for the

presence of sgemen,

3.0 EQUIPMENT/REAGENTS: C'g\‘(b\\@ Q/

Normal rocom ligh Sg d1 ns and the use of an alternate
light source t ie 1 cence emitted from semen stains.
Reagents fox‘%&m1 t on and identification are listed in
the appropniate oc ng protocols.

4.0 PROC@KE:
)

Seé?%low Chart on following page.
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RECEIPT & DOCUMENTATION
OF EVIDENCE AND PACKAGING

b
VISUAL/TACTILE EXAMINATION

(USE OF ALTERNATE HIGH
ENERGY LIGHT SOURCE)

BIL~110
Q%
/ NS
NO SEMEN DETECTED SU%@ED SEMEN
: _ s S LOCATED
NS
X
O
\%RE@TIVE SCREENING
NEGATIVE O N(BRENTAMINE)
(:) I-114
N RN
QO \@KQ SSS\SITIVE {or swabs)
o0 \@6 o
Nﬁfﬂﬁfvé>,( MICROSCOPIC EXAM
A BI-116; BI-118
N IS

;1@% POSITIVE

(
)
o

A

REvg&& REPORT y SEMEN
RESULTS OF N TO DNA ANALYSIS AS APPROPRIATE
EXAMINATIONS TO AGENCY

5.0 COMMENTS:

5.1 When examining pantsg/panties, a presumptive AP
gcreening will always be performed on crotches {(even in
abgence of visual cue).

5.2 A P-30 test need not be performed on item(g) which
yvielded a positive microscopic exam.

Revisgion 12
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MBI-104

EXAMINATION OF EVIDENCE FOR BODY FLUIDS

1.0 BACKGROUND:

Examination of items of evidence for the prese of body
fluids and substances other than blood or sem§h 1s sometimes
reguested and several methods are availablqéﬁo detect the
presence of saliva, urine and feces.

.\0

Sourcebook in Forensic Serology, Immqpslogy and Biochemistry
U.S. Department of Justice, NIJ, 19@ pp*’l97 198; 183-189;

191-195.

«C oA

2.0 SCOPE;: 0@ C) é
pLOYE ‘\ QD

To provide uniform procesé%hg g <f§$§glary material for the

presence of saliva, urlggbo

3.0 EQUIPMENT/REAGENTS fg\‘ \\Q) Q/

Normal room 11 1n <) ons and the use of an altermnate
light source \Uﬁf@ ﬁxrescence and assist in the
1ocallzatlo of body fluid stains. Reagents for
analy51s the:ﬁet d substancesgs are listed in the

approprx%t proce ng protocols.
4.0 PRO RE:

See Flow Chart on following page.
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RECEIPT & DOCUMENTATION OF
EVIDENCE AND PACKAGING

!

VISUAL AND TACTILE INSPECTION/
ALTERNATE HIGH ENERGY LIGHT SOURCE
BI-110

Y
l SUSPECTED BODY FLUID STAINS LOCATED |

L J %
URINE NS
I SALIVA ] J q?FECES |
v UREASE/CREATININE C;ED v
TEQT .
PHADEBAS /STARCH BI-126: BI-128 q;‘ UROBILINOGEN
IODIDE TEST ! D\'\ \ TEST
BI-122, BI-124 J/ c§:¢ N BI-130
¥ X O ¥ ™
POSITIVE | NEGATIVE POSITIVE , Aagxﬁ 42?3%ITIVE NEGATIVE
AN f) 7/
o & v
v <2 XSD \:>
FECES
AMYLASE DETECTED; %) \(\ C) INDICATED
PERFORM DNA ANALYSIS
AS APPROPRIATE N N2 v
NO URINE NO FECES
INDICATED INDICATED

4
4 v

REVIEW & REPORT RESULTS OF EXAMINATION TO AGENCY

5.0 COMMENTS:

5.1 Generally, feces samples and urine stains are not
processed for DNA. However, exceptions may be made in
instances where the sample represents the only
probative evidence.

5.2 Sample gize, and the significance of indicating saliva
as the DNA source, should be consgidered before
conguming sample for amylase testing.

Revigion 12
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MBI-200

INDIVIDUALIZATION OF DNA SQURCES BY STR ANALYSIS

1.0 BACKGROUND:

Once a DNA source has been detected, and identified ag to
'source type' where applicable and feasible, it 9 often
important to attribute the DNA sample to a pa<éacular
individual inasmuch ag possible. Current DNQStechnology, in

the analysis of S8TR loci, offers individu ation potential.
However, the individualization of a partdctlar sample occurs
through a comparative procegs. This p ess requires a DNA
profile from a ‘known’ gample to whi evidence sample
profile can be evaluated. DNA ana§$ 1 only be
performed when all necessary ‘kn

q;f) erence' sampleg,
for the given case, have been azpml he laboratory.

}\%
Although the analysis of %@53 *35\ £f individualization
potential, analysis may qg}:&y or performed on
u && t

every case and/or sa © the laboratory. DNA
analygig will only beﬁéz?' cases and/or individual
gsamples, which have tHe for regolving a probative
and forenszcally 22/ uestlon/lssue regarding the
given case. If V% of a sample resolves a given

gquestion, ad %&OH&@) ad@) s submitted for the resolution of
the same que€li Q<> E@B the case will likely not be
s

analyzed tem ich DNA testing has already been
perform w111 not retested, except in the instance where
new t ology has become available and has the potential to
res a guestion that could not be answered with the

oriddnal technology. Additionally, DNA testing may establish
identity, but does not establish timeframe or consent.

Sexual assault cases in which consent, rather than identity,
ig the issue will not be analyzed for DNA.

2.0 SCCPE:
To provide uniform processing of DNA samples to achieve high
gquality data and consistent intexpretation.
3.0 EQUIPMENT/REAGENTS:
Ag listed in individual analytical procedures.
Revision 12
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4,0 PROCEDURE:

RECEIPT & DOCUMENTATION N
OF CASEWORK SAMPLES

CONSUMPTION
A 4 NOTIFICATION?

EXTRACTION
BI-200 %

<
o
~h
v &
QUANTIFICATION % y
BI-207 . C

A

»

Y Y

(4
N
AMPLIFICATION @ VIl
BI-208 Q

h 4
CAPILLARY ELECTRI R

BI—21% \ /\C)
\ 4 Cﬁéb’ O¢> >~ 1
ACCEPTABLECL @ g)@x LE
P e
| g€ MAE@%})‘%(O) ALYSES
& h 4 O r +

g ACCEPTABLE NOT ACCEPTABLE

REVIEW & REPORT RESULTS
OF ANALYSIS TO AGENCY

)4.
Q
S
S

4

4

h 4

v

5.0 COMMENTS:

5.1 Careful scrutiny at each step will ensure insufficiencies
are ldentified, and compensated for where feasible, at the
earliest possible point (sgee BI-210 for specifics).

Revision 12
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BI-100

PROCESSING LIQUID BLOOD

1.0 BACKGROUND:

) .
Known reference standards in forensic casework m e received in
the form of ligquid blood, generally in a lavenggy top (EDTA)
tube, The EDTA acts as a preservative for th {even up to
geveral years post-collection); however, if ft in a liguid
state for prolonged periods of time (espemgally post-mortem
gamples), these samples are more suscep le to degradation,
potentially resulting in the loss of DEA. se liquid gamples
should be stored refrigerated to aid(d éé. preservation until
which time a bloodstain can be p redC) Bl;gdstains stored in a
dry state, even at room temperaﬂ@?g ‘Eﬁitable for DNA
testing for many vears. Bloo Qﬁ}a be prepared as soon
as feasible following sampl e erally at the time of
evidence analysis). Howe Qy 35$ev ce processing is to be
delayed beyond 2 months 7 em blood samples associated
with the case are to b A\h and bloodgtaing made for

preservation, &
&\ S &

2.0 SCOPE: e>

To provide a Qho&r(é%e creation of stable DNA samples from
blood. @{\Q O

3.0 EQUIPME EAGENTS :
N\
Blood Stain Card(s) (such as Whatman® non-FTA)
Envelopes
Disposable Transfer pipet or 1 m{ pipet with sterile tip

4,0 PROCEDURE:

4.1 Label stain card with a minimum of case number, item number,
date and initials. Subject name may also be placed on the
card for identification purpcses.

4,2 Label blood sample tube with case number, item number, date,
initials, and blood level. Mix the tube thoroughly by
inversion.

Revigion 12
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4.3 Remove cap from blood tube and draw ~1lmi{ of blood into
pipet. Carefully spot, at minimum, 1 drop (~50uf} blood
onto each circle.

4.4 Allow blocdstain card to alr-dry completely before
packaging.

4.5 Place dried stain card into an envelope (~3%" x 54"). Seal
envelope with evidence tape on flap and label with initials
and date across seal. Label front of coin eqé%lope with
Case Number and Item Number minimally. a{b

4,6 Make Casge DNA Packet (See BI-102) and Q%féé bloodstain
gample inside. .
\0
5.0 COMMENTS : Q
@
5.1 Exercise caution and wear app 1§i§3 tectlve gear when
preparing bloodstaing (e.qg. o]

&/ oat, protective
eyewear) . \
> é\, N\

5.2 Bloodstains are to be pa
gsash at the appropr%%gg é\
wearing a dlsposak%§;

5.3 Only one blood ple aégq should be open at a time. When
g, close one tube before opening

processing Tgi%&pl
another an alns are placed sufficiently far
away from(g c\§§>gaéﬁg processed to avoid cross-

contamgeéflon
QQ
Qﬁ

aer in the hood with the
at a workbench while

Revision 12
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BI-102

DNA PACKETS

1.0 BACKGROUND:

It has become increasingly important to retain idence for
possible future analyses and to secure sample&}for
nonprobative casework analyses that are n gsary for the
validation of any new technology. Theref&?e, where
possible, a DNA packet is created for eébh casgse that is
submitted for analysis to Forensic B gy and for which

evidence exisgts for retention . nce sample( 2)
and/or positive bioclogical scre‘egﬁé

2.0 SCOPE:
SCOPE \\ <</

To provide a method to enéagg qéq gsample retention for
gsample re-analyses and ng pgé}o echnology development.

3.0 EQUIPMENT/REAGENTS: %\ \\Q)G Q/Q
O &O A

Coin Envelopes %” and other sizes as needed)

DNA Packet E 9%" manila envelope}
Rlue, Greeno a% ircular Stickers

4.0 PROCEDURE(\.

Q§2t1ngs/swabs containing previcusly identified
{blologlcal evidence, as well as known reference
bloodstain cardg should be packaged in separate coin
envelopes. Swabs packaged in separate envelopes within
an outer container (gexual assgault evidence collection
kitg, for example) do not need to be repackaged into a
new coin envelope. Each envelope will be labeled with
Cage Number, Item Number, Date, Scilentist's Initials
and gealed with evidence tape.

4,2 All sealed envelopes will be placed inside a larger
manila envelope (DNA Packet Envelope) and labeled as
below.

Revision 12
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4,3 The DNA packet itself need not be sealed until biological
gcreening of the case 1s completed and all samples are
believed to have been collected.

4.4 DNA Packets for crimes without a statute of limitations
{i.e., Homilcidesg, and Sexual Assaults where DNA evidence
existe, including references for criminal paternity testing,
and no-suspect cases) will be identified by placement of a
blue circular sticker on the outside of the DNA Packet (see

below). Likewise, cases that have negative biological
gcreens {so that the DNA Packet will consist eiely of the
reference bloodstains, except criminal pate y cagesg) will

be identified by the presence of a yellcmrt&.cular sticker,
Green stickers will be placed on the Dq%fbackets of ail

other cases.
O
4.5 Once gealed, the DNA Packet will b£§?a en to a FES and
entered as an additional item o e to allow for
tracking in the ETS. The stoxé iQP will have a
barcode.

4.6 DNA Packets will be stcngb as space allows, and

then, if necessary, eilt to the submitting
agency, or placed in nlfgﬁp ure storage after any

regquested DNA ana%%§;%\gé§e performed. However, prior
to return to a sub y, the Biology/DNA Supervisor
should be notifa malntenance on site 1s no
longer neces%§£s>

Bednt O

Back

J%Lkmm\g%e~
itials
Q@" T
O o b
< L
S /

Evidence/tape
with initials
Blue, Yellow or

Green sticker

4.7 Following DNA testing, any leftover DNA extracts will be put
into a plastic ziplock bag or coin envelope and placed in
the DNA Packet. Individual tubesg may also be sealed with
parafilm or other gealant to prevent leakage and/or
evaporation if desired.

Revigion 12
Casework Analytical Methods: BI-102 5/23/12
Page 12 of 105 Igsuing Authority: Quality Manager




5.0 COMMENTS:

5.1 The DNA Packet

ig NOT meant to contain "items of evidence?!

but rather biological samples that have been removed from
itemg of evidence. Not every item or every stain on every

item should be
performing the
and experience
DNA Analyst or

included in a DNA Packet. The person
biological screening should use discretion
to prioritize gample selection, contacting a
the Biology Technical Lead i1f necesgsary.

5.2 Given the small sample necessary for DNA tes%i?g discretion
should be used in determining the gize of & stain cutting,
Rarely, 1f ever, should a cutting exceed dimensions of
the coin envelope. qagb

5.3 On RARE occasions when it is deemed essary to have more
gtains collected in a given case t ill fit into a single
DNA Packet Envelope, multiple pa ll be made. The
first packet’s barcode will c e case number
followed by DNA. Subsequent recelve barcedes
consisting of the case nu b@x vy DNA2, DNA3, etc.

QO \Q}
& ¥ X

Revigion 12
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BI-104

PHENCLPHTHALEIN TEST FOR BLOQOD

1.0 BACKGROUND:

Most screening tests for blood depend on the catqutic
action of the heme group. To minimize false po ives, the
test is frequently performed as a multi- stegck st. A good

&°
Gaengslen, R. Sourcebook in Forengsic Sgrdlogy, Immunology,
Justice, Washington,

overview is8 found in the first reference,

and Biochemistry. (1983} U.S. Dept.
L.C., p. 101-105,

Higaki, R.S. and Philp, W.M.S.
Stability and Specificity of.
Test for Blood, (1976) Can Q)
Vol &, No.3, p.9%7-102. <§

2.0 SCOPE (5\6
: : cé}. Q) <:>

N
To provide a metneé)foqs égéllzation and presumptive
identification

O\/
3.0 EQUIPMENT/RE;KGEN'J;{\ S
D
Phenolp <ﬁleln WdEDlng Solution
3% Hydwxegen Peroxide
Ster@)®/Nanopure H,0
Cogton Swabs or Filter Paper

4.0 PROCEDURE:

4,1 Posgitive {known bloodstain) and negative
(sterile/nanopure Hy;0) control gamples are processed,
prior to testing any forensic samples {on the day of
testing), to ensure the working solution reagents are
functioning properly.

4,2 Cotton swabs or a folded piece of filter paper are used
to collect the suspected bloocd onto the tip. A swab
may be moistened with sterile/nanopure H,0 if necessary.

Revigion 12
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4.3 To the swab or filter paper with the suspected blood, add 1-
2 drops of phenolphthalein working sclution. Wait 10-15
seconds to detect potential false positives.

4,4 Add 1-2 drops of 3% H;0; and note appearance or absence of
bright pink color. Color reaction should occur rapidly (£ 1
minute) .

4.5 Document result in case notes. Record positive {(+), as
indicated by the development of the above color change, or
negative (-) as indicated by the absence of %Sb color
change. Analyst may use other descriptive.<9 d{s) as well
(e.g., strong, weak, slow, etc.). g

%Q

5.0 COMMENTS : ‘\0

©

5.1 Direct testing of a small cuttingg%am€$§ may also be
performed.

< LK
5.2 Color changes occurring p 'ngt ition of 3% H;0: are
SIS
O

generally consgidered in &
a@\ é—fn. are generally
O Q
N &
0 O K
> K&
oY O~ AV

5.3 Color changes occurri@b

considered n@gati¥§;g>

Revigion 12
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BI-105

O-TOLIDINE TEST FOR BLOOD

1.0 BACKGROUND:

Mogst screening tests for blood depend on the catigégic action of

the heme group. To minimize false positives, the st is
frequently performed as a multi-step test. A g overview is
found in the first reference. qsz,

Gaengslen, R. Sourcebook in Forensic Serﬁg? , Immunology, and
Biochemistry. (1983) U.S. Dept. of Jus{} Washington, D.C., p.

101-105,

Cox, M., (1991) *A Study of th %ensgl and Specificity of
Four Pregumptive Tests for Bl f Forensic Sciences,
Vol. 36, No. 5, p. 1503-1511 &

<2

\.
Culliford, BJ and Nicholl; QDC @Q@s he Benzidine Test: A
Critical Review”, Jour%?gpbfqggr Sciences, 9:175-191.

2.0 SCOPE: &

To provide a me <; \bOcallzatlon and presumptive
identificationcgf ESS@

3.0 EQUIPMENT/‘%b NTS

0.3% Q% Tolidine Stock

3% rogen Peroxide
Sterile/Nanopure H,0

Cotton Swabs or Filter Paper

4.0 PROCEDURE:

4.1 Positive (known blocdstain) and negative (sterile/nanopure
H,O] control samples are processed, prior to tegting any
forengic samples (on the day of testing), to ensure the
working stock reagents are functioning properly.

Revigion 12
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4.2 Cotton swabs or a folded piece of filter paper are used to
collect the suspected blood onto the tip. A swab may be
moistened with sterile/nanopure H,O if necessary.

4.3 To the swab or filter paper with the suspected blood, add 1-
2 drops of o-tolidine working solution. Wait 10-15 geconds
to detect potential false positives.

4.4 Add 1-2 drops of 3% H,0, and note appearance ox&absence of
- blue-green color. Color reaction should ooQ@?’rapidly (=1

minute) .

4.5 Document regult in casge notes. ecor 81t1ve (+) as
indicated by the development of the ve color change, or
negative (-) as indicated by the a of the color
change. Analyst may use other d e word{g) as well

(e.g., strong, weak, slow, etq& (b

5.0 COMMENTS:
mRRAN LS <2C) \:§§>

5.1 Direct testing of a 9@%&1 wt tfzgysample may also be
performed. \
3 \® Q

5.2 Color changes Q& to the addition of 3% H,0, are
generally corg&re@ I\/ clusive,

5.3 Color cha %és :ﬁburﬁ%yg after 1 min. are generally

con51dg{§e ne

5.4 oqgalne ig designated ag a potentlal carcinogen and
2? be used with caution.

Revigion 12
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BI-106

HUMAN BLOOD IDENTIFICATION USING ABACARD® HEMATRACE® TEST

BACKGROUND:

Items of evidence with unknown sources of blood e often
submitted in forensic casework and it is usefutb o be able
to determine whether the blood is of human o The
basis of the ABACard® Hematrace® test is é%@,lmmunological
detection of human hemoglobin. ()

SCOPE:
SLOPR Q(\

To provide a uniform and reliabl Gk z ‘gE confirming the
presence of blood on evidentia at

C)
EQUIPMENT/REAGENTS : Q O\ @ @

OneStep ABACard® Hema%@zeg\@sté&

™ D
PROCEDURE : O W
0 K&

4.1 Label anﬁggésgrdééﬁ ﬁ&brace® test device for each

sample, S\ rols.

4.2 Add §$§ples QS%E buffer provided (generally ~2mm X
gtain cutt and allow them to extract at room

erature for 5-30 minutes {longer, if necessary for

d staing).

4.3 Apply ~150u¢ (4 drops with provided dropper) of a
sample extract to the 'S' well of its corresponding
test device and incubate at room temperature forxr < 10
minutes.

4,4 A pogitive result is indicated by the appearance
(within 10 minutes) of a pink line in both the control
'¢' and test 'T' areas. A negative result 1s indicated
by the absence of a pink line (after 10 minutes) in the
' area of a test device. Results are inconclusive
anytime a pink line fails to develop in the 'C' area.
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e

5.0 COMMENTS:

5.1

Samples must be at room temperature for the test. 1If
extracts have been stored in refrigerator/freezer, allow
them to reach room temperature before proceeding.

Both positive (known human bloodstain) and negative
{extraction buffer alone} controls are used.

concentration, as well ag other sample-speciifc factors, it
ig necessary to wait the full 10-minute i ation before
reporting a negative result. However, %Eﬁbsitive reaction
may occur in much less time. ()

Since the reaction time is dependent on heﬁzg% in

Ag with any antigen-antibody reac {gg false negatives {as

the result of a "high dose hook §§N may be produced

with concentrated samples. results are

obtained with very 'heavy S mple should be
further diluted and the tgsg)r%ggkt

5% Ammonia Hydroxide ged\sta , saline, 1XPBS or PCR-TE.
The volume used f t t1<:> y be reduced for sample
conservation or d e\ Q/ .g., 150p¢).

o X
Other reagents may be dgé ﬁé;%§;$;&0tion' For example, 3-
a

Although mos g nh&ﬁé égé01es tested do not produce a

positive «x h ABACard® Hematrace?® test, some

crossreacy é§$hA en reported {(e.g., other primates,

weasel erre g:l Therefore, when reporting regults,

the ségéément vi cated the presence of human blood’ should

be d, rather than ‘detected’ or ‘lidentified’. 1In

ézé@bnces where gpecies crossreactivity may be plausgsible, a
a

tement indicating that ‘members of the mustelidae family
cannot be excluded’ may also be used in the report.
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BI-108

SPECIES IDENTIFICATION: OUCHTERLONY DOUBLE DIFFUSION

1.0 BACKGROUND:

3.0

Methods commonly used to identify the species ofCorigin of a
biological sample are immunological in nature. he
Ouchterlony Double Diffusion technique was \ét described
in 1949 and involves the diffusion of anti y {(Abk) and
antigen {(Ag) in an agarose gel. The formafion and detection
of a precipitin line (as the result of'éQ—Ag complex
formation) is used to determine the qﬁgéies of origin of a
particular sample.

Gaensslen, R. Sourcebook in Fo 1c<éé v, Immunology,
and Biocbemistry. (1983} U. S‘éb ptqsb tice, Washington,
D.C., pp. 101-105,

Saferstein, R. Forensi @ble ook {1982) pp.284-297.
Cn\' 9

SCOPE: %\ \\®

O «©
In forensic bi é§; <§'18<gsually the determination of
whether a bl q?yﬁuman origin that is of concern.
That determi enerally be made using the ABACard®
Hematrace® test éﬁ%yer, there may be instances where it
is 1mpo%sa to de mine what nonhuman species was the
source a given sample or whether a nonblood sample is of
hum 1gln In thosgse situations this method may be used
ané@zs limited only by the availability of specific antisera
and positive control materials (this method may also be used
in place of the ABACard® Hematrace® test for the
identification of human blood}.

EQUIPMENT/REAGENTS:

3% Ammonium Hydroxide (for aged stains)

Antigera

Agarose, E25 or Sigma Type I

Glass Microscope Siide(s) (5 x 7.5 cm)

GelBond® {cut to 5 x 7.5 cm)

Agarose Punch or equivalent (e.g., pipet and vacuum)
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1M NaCt¢
2% Coomagsie Blue Stain and Destain solutions
filter paper

4.0 PROCEDURE:

4.1 Extract a small sample (e.g., 2mm° bloodstain) in ~50 ut
dH,0 (or 3% Ammonium Hydroxide for aged bloodstaings) .
Bloodstain extracts should be somewhat dilute and
straw-colored in appearance. Extraction tij and dH,0
volume will vary depending on stain coan\ ation in
order to achleve the desired straw colqg&supernatant.

%
4.2 In order for the agarose to sufficj %ly adhere to a
microscope slide, GelBond® must q%> dhered to the sglide

and the agarose gel formed on tdpof, it. Cut GelBond®
to the approximate size of yo i

mlgégscope slide and
adhere hydrophcbic side tca{% dz:ﬁ) h&e few drops of

dH,0 . Q/é

<
4.3 Prepare a 1% agarose g€l'b <£Bi 0.8 g agarase in 8
ml dH,0. Carefully ur r gel onto hydrophilic
side of the GelBoeﬁv A$§§i5§;hidification of gel.
X\

4.4 Using a pre—maégDOu le nY punch cr pipet/pipet tip
with vacuum e a ttern of Ag wells around a

central AQS%bll‘Qs dsa' ted below (~3mm between Ab and
Ag wellg{\ tQQ S@L ified agarose.
o O ,9

@@ O 0,0% 00 \

000 000
KOQ 00 00

<

4,5 Pipet appropriate antisera into central well (s) and
sample extract(s) (include a positive control of
interest and an extraction reagent blank; substrate
control where appropriate) into surrounding well (s).

4.6 Allow immunodiffusion to take place overnight, at room
temperature, in a moisture chamber (enclosed vesicle
with dH,0-moistened paper towel, filter paper, or
gponge) .
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4.7 Precipitin bands at this stage are besgt viewed with strong
backlighting against a dark background. The immunodiffusion
gel should be goaked, dried and stained for enhanced
visualization.

4,8 Staining

4.8,1 Soak immunodiffusion gel in 1M NaCt¢ for 2 6 hours (may
be left overnight) to remove uncomplexed proteins.

4.8.2 Ringe the gel in dH;0 for ~5 minutes; égﬁpen two plecesg
of filter paper with dH,0 and place op of gel,
followed by a stack of paper towels gserve as a
wick. Place a weight on top of & paper towels to
‘press’ the gel for 2 30 minuteg.~ Remove the weight,
paper towels, and filter pape d dry the gel in an
oven at 56°C-65°C for 2 20 Utes.

A\
4.8.3 Immerse gel in Stain SoZ%glﬂtfégx4@—15 minutes.

4.8.4 Destain until backg Qgg% né>bl and blue precipitate
bands can easily Q&een{‘

N
4.8.5 Rinse with de%,@h%A&m&? dry.

Wi
5.0 COMMENTS : 0 Q A
_— X» <Z/
5.1 A clear, é@? 1t1n band between the antisera well

and sampl \:> 081t1ve test result. Extraction
blanks ,&ould %atlve (i.e. no precipitin band present).

5.2 “Spu@%z may be seen on precipitin bands produced from

Zié;% y related species.

5.3 Note: the gel/GelBond will separate from the glass slide at
gsome point, however, the gel should remain in contact with
the GelBond.
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BI-110

BIOLOGICAL SCREENING: USE OF ALTERNATE LIGHT SOURCE (ALS)

BACKGROUND ;
9

There are numerous forensic applications for thqb e of
alternate lighting. In forensic bilology, it 'ébgenerally used
to aid in the visualization of physiologic?§> luids and trace
evidence such as fibers,

'\
SCOPE: (\6

@

To provide a method for enhan01ng &jﬁéﬁ% n/localization of
physiological fluids and trace ev nce as‘Pp essary for

N
preservation) on evidentiary 1*@ @ &

EQUIPMENT/REAGENTS: <2

Alternate Light Source Q}
%@bg

Filtered Safety Goggl
QN

4.1 Selectlon<§f hﬁg 1?§2ngth of light for viewing will depend
on the tern t source used, itsg available outpute,
and t bstrat&ihelng viewed. A broadband source covering
<53 wavelengths ig sufficient for biological examination
b .11l not eliminate potential background fluorescence as

11l as the use of a discrete wavelength band. Optimum
visualization of physiological fluids and fibers is
typically achieved at ~450nm and ~485nm, respectively;
however, it is often necessary to test each of the
wavelengths (450nm ~ 540nm) and choose the most appropriate
based on the background fluorescence encountered with the
particular substrate. The following table illustrates the
appropriate safety goggles to be used with various source
outputs.

PROCEDURE :
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Wavelengths Safety Goggles

< 400 (UV) Yellow/UV safe
< 530 broadband Orange
400-450 discrete Yellow
450-540 discrete Orange
540~700 discrete Red
700-1100 discrete | Red or IR safe
>700 broadband

4,2 Follow manufacturer's operating instructions é%% gpecific
details on equipment operation. \SS)

4.3 Examine evidence under optimum discret@éﬁgvelengths where
possible and under appropriate broadb output when
discrete wavelengths are not availah%E.

4,4 Mark any fluorescent areasg/pote al stlogical stains, as
appropriate and necessary, fofideas cation under normal
room lighting conditions. Q/

9 X
W@
4.5 Proceed to appropriate €Z§%e '§§; edure (8) for any
possible biological SH?} 8 €§S§ (see BI-114; BI-122; BI-
124; BI-126; BI- 128

& Q’b@Q
MY A
5.1 Failure to u%bsa@ &les, or uge of incorrect goggles

could resu Nin ant eye damage. Avoid looking into
?%h other individualg. Read any

the wand &p s 1
manufa rer's siégby guidelines provided with the
equi t.

5.0 COMMENTS:

5.2 EZQQ%Vloiet light may cause burns, so caution should be
ercised to avoid direct and/or prolonged exposure to
unprotected skin. Read any manufacturer's safety guidelines
provided with the equipment.

5.3 The alternate light source wand can generate heat and
potentially cause burns to skin and other materials. Read
any manufacturer's safety guidelines provided with the
egquipment.
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BI-111

BIOLOGICAL SCREENING: USE OF INFRA RED LIGHTING

1.0 BACKGROUND:

In forensic biology, IR lighting/photcgraphy Eggbbe used to
aid in the visualization of physioclogical £l , typically
blood, on dark substrates that would normalk make it
difficult to see the suspected stain. CESD

2.0 SCCPE: \

of bloodstains on evidentiary 1

To provide a method for enhancin kiéﬁtlon/locallzatlon
t:§é$ )

3.0 EQUIPMENT/REAGENTS: \C) Q/
\ KQ \)®

Digital Camera equipped 62 h ngfti)
‘Night Shot’ video cam e} ()
A "

xO
07 N
4.1 Follow man é%tu(ze\r %p@rating instructions for

fi t t
speci lQ\ €£§Doq:y uipment operation.

4.0 PROCEDURE:

4.2 Exam féé 632h81ng the ‘Night Shot’ getting on the
qg% amera. tains will appear dark against a
ter background, under IR, when observed through the
<2§ era viewfinder.

4,3 Mark any potential bloodsgtains, as appropriate and
necessary, for ease of location under normal room
lighting conditions.

4.4 Proceed to appropriate screening procedure(s) for any
possible bloodstaing located (see BI-104; BI-105)

5.0 COMMENTS:

5.1 Stains may be documented by still photos, using the
video camera or with a digital camera equipped with an
IR filter.
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BI-114

BRENTAMINE TEST FOR ACID PHOSPHATASE

1.0 BACKGROUND:

Acid phosphatase i1s an enzyme found in elevat mounts in
human semen, independent of the presence of spermatozoa.
Various tests have been used for its detecgion. Though none
of these tests are prostate-specific, at e limits of their
detection, they are a good indicator o céhe presence of

semern. <>

@
Gaensgslen, R. Sourcebook in For Qc@@» gy, Immunology,
and Biochemistry. (1983) U.S. pt . \of QP@ ice, Washington,

B.C., p 155-166. <§b Qb

N

Biology Methods Manual, Mg%ropQ?étCE:POlice Forensic Science
Laboratory, p.3-16 throqgh 3\$§.

AR
2.0 SCOPE: (%) \\Q) Q/
— O O
To provide a éﬁgd ait’in location and presumptively
identify th§<g§bse e ff}ﬁémen stains.

3.0 EQUIPMENTAREAG SQ)%
&0
Brentam®ne Solution A
Brenfamine Solution B
Sﬁéklle/Nanopure H,0
Cotton Swabs or Filter Paper

4.0 PROCEDURE:

4,1 Prepare Brentamine Working Stock: Mix 1 part solution A
and one part solution B with 8 parts of water. This
solution should be prepared fresh each day it is used.
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Pogitive (known gsemen stain) and negative (moistened swab or
filter paper) control samples are processed, prior to testing
any forensic samples (on the day of testing), to ensure the
working stock reagents are functioning properly.

Lightly rub a suspected semen stain with a pre-moistened
cotton swab, or press a moistened piece of filter paper
against the stain.

9

Add Brentamine Working Stock to the swab ox\ flter paper and
obgerve for the appearance or absence of ink to purple
color change. QD

To avoid false positives, the resu hould be recorded as
positive({+), as indicated by the éﬁi\ pment of the above
color change, or negative(-), as\' K§£§£d by the absence of
the color change, within 1 mJ.? c“l addltlon of the

Brentamine Reagent. Additi , strong,
weak, slow, etc.) may alsqsge h o record

\
COMMENTS : QO \Q} \>

5.1

Pogitive reaction X&bho <§§P lly weak, may be obtained
on anal/rectal an nal swabs in absence of any
semen. \(\ &

fo N <</
The test @ﬁ&formed uging 10-20ut of a sample
extract o 6&@ o a small cutting.
This \5 may algblxaused for mapping large, possgible semen

stai via a moistened paper transfer method. A sheet(s) of

{Sened filter paper is pressed against the item of
ggﬁdence. Marks are made on the paper to indicate the edges
of the evidence for orientation of any subseqguent coloxr
reaction. The paper is sprayed with Brentamine Reagent and
analyzed as ahove.

Fast Blue B is a possible carcinogen and should be handled
cautiously.
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BI-116

SAMPLE EXTRACTION FOR SEMEN IDENTIFICATION

1.0 BACKGROUND:

The identification of semen is a multi-step procégs for

which 1t is necessary to generate extracts of, ative semen
staing for use in the identification tests.‘QA
%)
2.0 SCOPE: Qb
.\0
To provide a method of generating su le extracts from

(ag needed) and confirmatory te presence of

evidentiary wmaterial for the perfo Q;éiksboth presumptive
gsemen, as well as other forensi

C)
3.0 EQUIPMENT/REAGENTS: QO\ KQQ @
Small (e.g., 12x75mm) ggbeS\é} 5m€ microfuge tubes
Centrifuge é\‘(b b 0
4,0 PROCEDURE: &
4.1 Label tubﬁ@)w fying information.

4.2 Tak@ g%mﬁi} mm? portion of stain or ~1/8 each of
one_© two codébn swabs), transfer to the appropriately
1 ed tube and extract in a minimal volume {(50u¢ -
\Q ul) of dH,0 at RT for = 20 minutes.

4.3 At this point, agitation, wvortexing, brief sonication
and/or piggyback centrifugation may be used to assist
in removing sperm/cellular material from the substrate.

4.4 Mix/resuspend the sample for use in microscopic
examination (BI-118) and/or p30 detection (BI-120).
Alternatively, the supernatant may be removed, without
disturbing the pellet, for additional testing [e.g. AP
screening (BI-114), p30, etc.] prior to resuspension.
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5.0 COMMENTS:

5.1 Other reagents may be substituted for dHO {(e.g., 1XPBS, PCR-
TE, saline) in 4.2.

5.2 The sample sizes and extraction volumes are those typically
used and are recommendations. The scientist has the
discretion to increage or decrease the gample size and
corregsponding extraction volume as case circumstances
dictate.

9

5.3 While the primary use of thig liquid extracﬂj@% for semen
identification testing, these extracts ma e used for other
screening tests as well {e.g., Saliva,c%ﬁﬁne, feces}.

5.4 The sample may optionally be extracésg)in dH,0 directly on
the microscope slide at the analysi® iscretion. However,
the quantity of sperm cbserved m be~Hminished and no
gsample will remain for furthexkgés ) LQ;g. p30) when using
thig method. Q

’\C)
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BIr-118

SEMEN IDENTIFICATION: MICROSCOPIC EXAMINATION

1.0 BACKGROUND:

The visual identification of spermatozoa is a meam® of
pogitively identifying human semen. Human spery Have a
distinctive gize and morphology and, with dl‘é§$ent1al
staining, such as the "Xmas Tree" method, éé?@ e readily
identified.

Gaensglen, R. Sourcebook in Forensiizgg%ology, Immunology,
and Biochemistry. (1983) U.S. Dept

D.C., pp. 150-152, QO C)O &
SCOPE: ()@ @ Q/é
— OIS
To provide a conf1rmatory<2estxgg} identification of
semen in cases where sa;éﬁataéba present.
3.0 EQUIPMENT/REAGENTS: (0 \\® Q
O A

XMas Tree Sta:L @111 \on @

XMas Tree St S

295% Ethancé?

Glags Mic cop Slﬁa;?

Cover S Q

Mount i Medlum

4.0

MlC &38%ope (Magnification ~200X-400X)
PROCEDURE‘

4,1 The sample extract is mixed well and ~5-10pé{, or ~10%
deposited on a microscope slide and allowed to dry

Juatice, Washington,

(this process may be expedited by use of a slide warmer

or oven at ~37°C).

4,2 Heat-fix the sample extract to the slide by slowly
passging over a flame (alcohol lamp or Bunsen burner) .
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4.3 Cover the heat-fixed sample extract with Xmas Tree Stain
Solution A and allow staining for 2 15 minuteg at RT.

4,4 Remove the gtain with a gentle stream of dH,0 and cover the
stained area briefly (~15-20 seconds) with Xmas Tree Stain
Solution B. Remove this stain with a stream of EtOH (95% or
Abgolute)} .

4,5 Allow the slide to dry and apply mounting medium cor dHzC and
a cover-slip prior to microscopic examination.

4.6 Scan the slide on 2200X magnification. Spen@zheads will
retain the red stain, while the tails, if egent, will
appear green. Use 400X magnification %§§h cegsary to verify
sperm morphology.

O
4.7 Documentation in notes should 1nc1{§2 the following:
4.7.1 A description of the co é(% he gperm seen (e.g.
heads only, mostly hea , ete.).

4.7.2 An estimate of th eé?b j§§érm seen per field

(e.g., 12/Sllde, 1/ /200X; 5-10/200X;
>10/200X; or 1+ 49\ A representative
photograph t ﬁ§ t verall rating of the glide
shall be tgb igglYded in the note packet (see
BI-119) Q\}Q \&'O

4.7.3 The ﬁg& ofc§h9 epithelial cellgs {e-cell) and

the }S§§ rare, occasicnal, few, moderate,
. The scientist may alsoc note e-cell
Qi‘ crlptlo e g nucleated (NEC or nuc.) or
nucleated (ANEC or Anuc.)] and whether or not there

o
4.7.4 If the sgituation arisgses in which there are only one to
three sperm heads, a single intact sperm, or a few
sperm heads of guestionable morphology, a second
gualified scientist must verify the identification
(date/initials in the case notes). A photograph of
the single sperm shall be taken and included in the
note packet (see BI-119).

are large gguamous eplthelial cells present.

4,.7.5 For ease of re-location, the pogition of gperm in
cages where 2 or less have been identified should be
documented in the case notes.
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4.7.6 It is also good, if possible, to note the presence of
gsignificant amounts of bacteria, yeast or white blood
cells.

5.0 COMMENTS:

5.1 Stains purchased commercially have expiration dates,
while those prepared 'in-house' are generally stable for
~ 6 months at RT. After this period, stains should be
disgcarded cor checked with a posgitive (kn%gb gperm) slide

before use. A\O
)
9
(\é\o
@ N
\
© K
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BI-119

DIGITAL IMAGING

1.0 BACKGROUND:

Digital photography ig frequently used to document the
presence of spermatozoa identified through mk§@bscopy,
the general appearance of evidence items o Mndividual
staing, and/or to aid in the documentati f tests
performed during analysis. Foray Technoégg%es’
Authenticated Digital Asset Managene tgsystem (ADAMS) -
Digital Workplace allows for imagescga be imported,
gtored, and printed for inclusio @n t cage file.

Digital Workplace, in combinat@ wit@ ggge Photoshop,
in n

tracks the image history, inc §§$§ ifications
(e.qg. brlghtness/contrast/c djustments,

annotations) made. A varl Qh may be printed to
include the selected 1m <%£;350c1ated cage/history

information as appropggﬁte\\

ADAMS Uger Manual% \\® 0

Adobe Photoslg@ Os \&21{1?9
2.0 SCOPE: ‘\ \)(\ Q)%O

To pro(b a meaﬁé)c{ printing digital images for the
ca le and storing the associated image files.

3.0 %IPMENT/ REAGENTS :
£

Imaging Computer with Monitor
ADAMS and Photoshop Software
Microscope

Digital Microscope Cawmera
Digital Hand Held Camera

Printer
Casework Analytical Methods: BI-119 Revision 12
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4.0 PROCEDURE:
4,1 IMAGE ACQUISITION

4.1.1 Login to the imaging computer and double click
the Digital Workplace icon on the desktop.

4.1.2 Click File>Acguire>From Folder. Browse to the
location of the image(s) and select thoge to be
imported (note: images should be transferred from

the camera to the computer and re ed with a
degscriptor such as item number,. or to

importing) . Select ‘Open’. 6\
%
4.1.3 Enter case information intg<fhe “Acquisition
Info” dialogue box. Cas‘\ umbergs are to be

entered as ‘Case # - yst initials’. Select
‘OK’. The software ign a unique
identification nun g:g) Q&Klmage, in addition
toc the 1mported

o @
4.2 IMAGE PROCESSING Q 0
& .
4.2.1 Imagesqgéb'be 1 in various formats using the
‘View’ ptﬁ§§ toolbar. If applicable,

d s/notes may be added under the
' et qQr zétlon’ view.

\(,O
4.2.é§lg;SECes§é;;, images may be processed using
~§ Ph 2§§b. Processing may include adjustment of
{S’ brigh contrast, and/or color balance as
(fb well asg cropping or adding annotations. Select
{S) the image (s} to be processed and click the
<2 Photoshop (Ps) icon on the toolbar.

4.2.3 Make the necessary adjustments in the Photoshop
window and close when complete. Choose ‘0Ok’ in
the dialogue boxes that appear. The ‘processed’
image (s} will appear in the Digital Workplace
view, in addition to the original image. The
processing history may be viewed in the ‘asset
details report’ or the ‘asset information’ wview.
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4,3 REPORT

4.3.1 Highlight image(s}) to be printed, click
File>Reports, select report type and click “Ok”
in the printer dialogue box.

4.3.1.1 Select “Asset Detail Report” for an image
with descriptions and notesg. Choose the
desired information to display in the
“Agset Details Report Optiong” dialogue

box. )
<
O
4.3.1.2 Select “Contact Sheet”\gb display
multiple images peq2§ége.

4.3.1.3 A single large imade may also be printed
directly by ch E§ File>Print.

4,3.2 Exit Digital Woxkp%&é (3

LQg off of the imaging
computer when do

S

0 @
Qo\ @
5.0 COMMENTS:

5.1 At the comple& &hnical/ac‘xministrative
review, the ca <; 11l enter the case onto a
“Cages to @%rc\g orm.

’b
5.2 Image (i?!%ed to CD/DVD by the Digital Imaging
Syst A%:§®1Sﬂ%9 or or designee as needed. Archive
d%&éf wi c> ored in the laboratory evidence vault.

S.B@ekly system backups will be conducted by CJIS

<2{$> ersonnel.
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BI-120

®
IDENTIFICATION OF SEMEN BY P-30 DETECTION (ABAcard )

1.0 BACKGROUND:

P-30 is a seminal-fluid-specific protein. Itﬁféresence in
gemen ig independent of the presence of spe WAt ozoa .

Immunological detection of p30 is common sed as a
confirmatory test for the presence of semen.

N\
Sensabaugh, G. F. “Isolation and Cha@g%terization of a
Semen-Specific Protein from Human Qgh Plasma A
Potential New Marker for Semen (ii ion. (1978)

Journal of Forensic Sciences, ®3 12\' OQ/% 5.
Spear, T F. and Khogkeba (SbN <§}%;S§baluatlon of the

ABAcard p30 Test for the<Xrdeaddf ficaeion of Semen.” (2000)

Crime Scene, 26 (1): 8- )
O QO

. : S @
2.0 SCOPE:. S O\\

O A
This procedure é§§b fgfueé%Vas a confirmatory test for the

instances where a positive AP

presence of
result was {;f} o spermatozoa were seen upon
m ¢51

microsco exa of the sample extract.
Pk» D

3.0 EQUIE&%T/REAGENTS :

Oég%tep ABAcard p30 Test Kit

4.0 PROCEDURE:

®
4.1 Labkel an ABAcard p30 test device for each sample,
including controls.

4.2 Add 10pt! of each sample (see BI~116), and positive
{(known semen stain extract or Seri™ semen standard
[10ng; 10u¢ of a 1:100 dilution]} controls, to the
extraction buffer provided. Mix thoroughly.
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4.3 Transfer ~150p! of each extract (4 drops with provided
dropper) to the 'S' well of the appropriately labeled test
device and incubate at RT for 10 minutes.

4.4 A positive result is indicated by the appearance (within
10 minutes) of a pink line in both the control 'C!' and
test 'T' areas. A negative result is indicated by the
abgence of a pink line (after 10 minuteg) in the 'T' area
of a test device. Results are inconclusive anytime a pink
line fails to develop in the 'C' area.

9

0
\
N
5.0 COMMENTS: %Q
5.1 Samples must be at room temperatuxe’for the test.
5.2 Other reagents may be substltuéé the extraction
buffer (e.g., saline, 1XPB&2 CED A%ho) in 4.2 if
necessary.

0@
5.3 8ince the reaction ti €§§§ht on p30 concentration,
as well as other sam actors, it is necessary

to wait the full 1&\ ation before reporting a
negative result <55381t1ve reaction may occur in

much less time.

O

5.4 As with a ‘<%t1Q§ /a body interaction, excess antigen

may lea ge hook effect’ regulting in false

negatzvé%» O concentration is very high. This

effe sho on51dered when examination and
§§§t1ve te have indicated the likelihood of the

pxégénce of semen. In those instances, the sample should
459 diluted and the test repeated.

%
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BI-122

AMYLASE TEST (PHADEBAS)

1.0 BACKGROUND:

Amylase is an enzyme that is present in high concengfatlons in
saliva relative to other body fluids and its dets on is
indicative of the presence of this body fluid. is method for
the detection of amylase consists of a tablet water-insoluble
starch, cross-linked to Cibacron Blue dye, tﬂ%} ig hydrolyzed to
water-soluble blue fragments in the presenc& of alpha-amylase and
detected by blue color develcopment of thgﬁbolutlon

Biochemistry. (1983} U.S. Dept %g shington, D.C,,
184-187.
P {b Qb

Auvdel, Michael J. “Amylase vekigxngi:y n and Saliva Stains”

(1986} Journal of Foren81q<gp 426-431.

<
Gaensslen, R. Sourcebook in Forensaiggé é§$§ Immunology, and
ei §§&

Keating, S.M. and nggéz;b QD 2Zy etectlon of amylage on swabs
from sexual assault c@}es"() 1%2 Journal of the Forengic Science
Scciety, 34 : 85- 932>

G.M. Willott, * st for the Detection of Salivary
Amylase in St ou of the Forensic Science Society, 14,
pp. 341- 344{(\1 74)

Phadebai§§aylase Test directions for use, Pharmacia AB, Uppsala,
Swedeﬁz 994 and Magle AB, Lund, Sweden, 2007.

2.0 SCOPE:

To provide a presumptive screening test for the presence of
gsaliva on evidentiary items.

3.0 EQUIPMENT/REAGENTS:

Phadebasgs Tabletsg
0.5N NaOH
Sterile/Nanopure H,0
12x75mm tubes
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Corks for tubes or parafilm™ or equivalent
4.0 PROCEDURE:

4.1 Stain samples (~2-5mm®; %-% swab; 20u{ extract) and controls
[20u¢ dHxO is used for negative control; 20p¢ of 1:100 and
1:500 dilutions of fresh saliva and either neat saliva, or a
saliva stain {£2mm® cutting) as positive controls] are placed
into appropriately labeled tubes.

9

4,2 Add 1m!{ dH;0 and 1/4 Phadebas tablet to eaoQSg%be, cover
tube, mix well (e.g. vortex} and incubate<ﬁt 37°C for 30

minutes. CESD

4.3 At RT, remove cork, add 250u?¢ 0.5N Q%Sﬁ to each tube, cover
tube, mix well by inversion and 88§p r 5 minutes at low
speed (<5,000 rpm). f&

o R

4.4 Examine tubes and record theQ§ fCQf Q%fasupernatant. The
intensity of the blue cohﬁé) e may be graded asg
light, medium, dark, or *.(S}Qi> orting, see 5.1.

N
5.0 COMMENTS : x@ O O
e

5.1 If the blue colo 15 ag dark or darker than that

of the 1:500 c Q\Clt 4@ an indication of an elevated
level of amy '4&@orted as such. If the blue color
of a sampl \ié an the 1:500 control, there is an
indicatio € 1s present; however, there is no
demons tlon. ié)elevated level. A sample that

demon tes abs e of blue color consistent with the

neg e control is reported as ‘did not indicate the

{596 ce of amylage’. Note: negative gampleg (like the
géntrol) may have a very slight blue tint and not appear
perfectly clear.

5.2 A negative result is not necessarily the total absence of
saliva, and therefore, DNA testing should not be abandoned
because of the absence of detectable amylase activity.

5.3 This test 1sg not human specific, there may be reactive
amylagseg in plants and non-human animals,
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BI-124

AMYLASE TEST (STARCH IODIDE)

1.0 BACKGROUND:

, . N N .
Amylase is an enzyme that is present in high cq&éﬁhtratlons in
saliva relative to other body fluidsg and its tion is
indicative of the presence of this body flui " This test takes
advantage of the amylase-catalyzed starch ﬂ%gaolysis that
results in short polysaccharides unable & react with iodine
which is detected ag a ‘clearing zone' ound csample wells
containing amylase.

O
Gaensslen, R. Sourcebook in Forené& ‘éé\ Immunology, and
Biochemistry. (1983) U.S. Depﬁc) f é&s M%s Washington, D.C., p
184-187.

Luvdel, Michael J. Amyla qaLequé' emen and Saliva Stains,
(1986) Journal of Fore 31 (2) 426-431.
Keating, 8.M. and Higgs, é§%‘<§ detection of amylase on swabs
from sexual assau %§§ Journal of the Forensic
Science Socuat{\ @ 6\/
2.0 scopE: QQQ,%
&

To provi a presumptlve gcreening test for the presence of
saliva evidentiary items.

QK

3.0 EQUIPMENT/REAGENTS:

Agarosge (Sigma Type I or eguivalent)
Soluble Starch

Amylase Diffusion Buffer

Iodine Solution

Petri Dish

4,0 PROCEDURE:

4.1 Sample and control extractg {(dH,O0 is used for negative
control} should be prepared in dH,0 as usual (See BI-116).
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4,2 Prepare a 0.1% agarose/0.0l% starch gel by dissolving 100mg
of agaroge and 10mg of soluble gtarch in 10m!{ of Amylase
Diffusion Buffer. Pour the gel into a {~9cm) petri disgh,
allow it to golidify, and punch wells ~2 mm in diameter, and
at least 3 cm apart, into the gel.

4.3 Fill wells (do not overfill} with sample extracts and
controls.

4.4 Mark petri dish for orientation and document sample

placement. ng
4.5 Cover petri dish and allow diffusion overpight at 37°C. May
be placed in a humid chamber. CESD

4.6 To develop, flood the petri dish wi c»Llomf of 1:100
dilution of the iodine soclution 1(} {/10m¢ dH,0), let stand
a few moments to develop the pu€§\ r, then pour it off
the plate’s surface, C)

4.7 Record the results by mea ﬁ}ng éﬁe eter of the clear

clrcles. For reporting<2
5.0 COMMENTS:

= G O

5.1 Positive controls Qg} de 1:100 and 1:500 dilutions
of fresh sali at saliva ox an extract of a
known sallvaeSES\ clear zone of an extract 2 that
of the 1:500€on 15 an indication of an elevated
level of 1n e extract and is reported as such. If
an ext t clé:% zone smaller than the 1:500 control,
therquggén 1nd12;}10n that amylase is present; however,
the 8 no demonstration of an elevated level. An extract

emonstrates no clearing zone is reported as 'did not
1cate the presence of amylase!'.

5.2 Additional standards such as neat semen, neat urine or neat
vaginal fluid may be tested as needed.

5.3 A negative result is not necessarily the total absence of
galiva, and therefore, DNA testing should not be abandoned
because of the absence of detectable amylase activity.

5.4 This test is not human specific, there may be reactive
amylases in plants, bacteria, and non-human animals.
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BI-126

DETECTION OF URINE (UREASE)

1.0 BACKGROUND:

Urea, is a normal metabolite found in high conc ation in
urine. The urease reagent reacts with the ured) Present in a
urine staln and releases ammonia, which may Qé detected with
litmus paper.

Gaensslen, R. Sourcebook in Forensic § <glogy, Immunology,
and Biochemigtry. (1983) U.S. Dept gstice, Washington,
D.C., p. 191-195, &

(<O
Metropolitan Police Forensic SCQFHCG\, éé%%ory Bioclogy

Methods Manual, 1978, S8Sectio \‘

0
Q
2.0 SCOPE: \(\ C)

To provide a presu veQ%ééf%pr the presence of urine on

relevant ev1dent

3.0 EQUIPMENT/ REM}&

Urease Regéent 0 @

Sterile nopure H§;>

Small rks (to fit 12x7bmm test tubes)
géﬁﬁ% test tubes

Litmus Paper

4.0 PROCEDURE:

4.1 Cut out ~2.0cm® piece of suspected urine stain and
controls, cut them into small pieces and place them into
appropriately labeled 12x75mm test tubes.

4.2 Add 3-4 drops of dH;0 and 6-7 drops of Urease Reagent to
each test tube.

4.3 Cut a glit intoc the bottom of each cork and insert a
small piece of red litmus paper into the slit.
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4,4 Place one of the corks {(with litmus paper) into each tube;

do not allow the litmus paper to come into contact with the

liguid.
4,5 Incubate the tubes for 30 minutes at 37°C.

4,6 Note and document any change in the color of the litmus
paper that occurs within the incubation time. A positive
reaction (+) isg recorded when the red litmus paper turns
blue. When there is no color change noted, a negative(-)

result is recorded. ng
Ny
5.0 COMMENTS: %Q

5.1 Controls include positive (known und#e stain) and negative
{dH;O blank) and a substrate con 1 where appropriate and

avallable. K

5.2 The Urease Test ig one of ﬁgy Q%f ve tests for urine;
t

a confirmatory test foxr ion of urine in a
dried stain is not ax@@\}bl 0

Revision 12
5/23/12

Casework Analytical Methods: BI-126
Issuing Authority: Quality Manager

Page 43 of 105




BI-128

DETECTION OF URINE (CREATININE)

1.0 BACKGROUND:

Creatinine, the anhydride of creatine, is a norm&i
congtituent of urine and 1s a waste product o ormal
metabolism., It is present at high levels i ~\rine compared
to other body fluids. This test ig base@gfﬁ itg reaction
with picric acid and is detected by a cib change from
yellow to orange.

Gaensslen, R. Sourcebook in Foren%SébSexéiog Immunology,
and Biochemistry. (1983) U.S ice, Washington,
D.C., p. 191-195,

& &
Metropolitan Police Forens%& 6ﬁ e ratory Biclogy
Methods Manual, 1978, db i§>
RN Q
2.0 SCOPE: (O N
SCoPR O o\ «Q/

To provide a p&i}' {S{ for the presence of urine on
relevant ev1Q€ (:) al.

3.0 EQUIPMEN’I‘é@AGEbﬁé Q)

NaOH
St ile/Nanopure H,0
Concentrated Glacial Acetic Acid
12x75mm test tubes

Satu ¢§§d Picric Acid Sclution

4.0 PROCEDURE:

4.1 Cut out ~0.5 cm® piece of suspected urine stain and
controls and place them into appropriately labeled
12x75mm test tubes.

4.2 Add 0.5 m! of dH,0 to each test tube and extract for 15
minutes at RT.
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4,3 Remove the substrate. Add 1 drop (~50 ut{} of Picric Acid
Solution and 1 drop (~50 ptf) of 5% NaOH to each tube.

4.4 An orange color develcps fully within 15 minutes and is
stable for approximately 2 hours. The orange color is a
positive indication of Creatinine. The negative control
stain solution should remain yellow.

4,5 Document results in case notes. Record pogitive (+) or

negatives (-). Analystg may ugse other descriptive word (g)
(e.g., strong, weak,) or numerical gradln%égﬁ a., 1+ - 44+)
as well. \0
A
@
5.0 COMMENTS : %

5.1 Controls include posgitive (known{g?lne stain) and negative
(dH,0 blank) and a substrate CQSQ &?*here appropriate and

available. Q C)O &
>

5.2 This method is not speci ﬁgg?f s\C‘r nine. Although other
chromageng are detec cedure, their
concentrations are n

5.3 Among other sub ese}gl is reported to produce an
orange coloxr w1 lcrate, although the color is

pale. Howe (Bh ﬁi' s likely to be confusion between

this and 1neé§t zb/the addition of 2 dreops of glacial

acetic 6;%/creatln1ne containing sample pale
nutes. (The color can be restored by

yellow<3 té:§§ i
add]sgsE giibb of 5% NaOH). Heat is necessary to

g¥3z§ the coldr change to pale yellow if the stain is
ose

S‘?QThe Creatinine Test is one of many presumptive tests for
urine; a confilrmatory test for the identification of urine
in a dried stain is not available.
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BI-130

DETECTION OF FECAL MATERIAL (UROBILINOGEN)

1.0 BACKGROUND:

Edelman's Test is a presumptive test for the presence of
fecal material and is based on the detection of obilinogen
which is found in high concentration in feces robilinogen,
which is oxidized to urckilin, is soluble i cohol and, in
the presence of neutral alcoholic salts, qu& form a green
fluorescent complex with zinc.

o

Gaensslen, R. Sourceboock in Foren51 ogy, Immunology,
and Biochemistry. (1983) U.S. De stlce, Washington,
D.C., p. 191-195.

Metropolitan Police Foren51c égég?atory Biology
Methods Manual, 1978, Sec \
\Q)

2.0 SCOPE: QSS>

To provide a presg&BtLQé) §§%~for the presence of feces on

relevant ev:LderB ryoﬁ}da{/

3.0 EQUIPMENT/RE§§333$> S

Q
10% ?{\Mercurzc @1orlde Solution

10% Zinc Chloride Sclution
Any Q gopentyl) Alcohol
Steklle/Nanopure H,0

12x75mm test tubesg

Alternate Light Source

4.0 PROCEDURE:

4,1 Cut out ~0.5 cm® piece of suspected fecal stain and
controlg and place them into appropriately labeled
12x75mm test tubes.

4.2 Extract gamples in ~3 drops of dH,O for 15-30 minutes at
RT,
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4.3 Remove the material and add ~3 drops of 10% Zinc Chloride
Solution to the extract.

4.4 Add 5 drops <of Amyl Alcohol to the extract and vortex.

4.5 Spin sample for 5 minutes on low (~2000 rpm) in the
gerological centrifuge and transfer the upper phase to a new
12x75mm tube.

4.6 To the upper phase, add 3 dropsg of 10% Mercuric Chloride
Solution and observe any color change under bQ€?>whlte and
long wave UV light. O

A\

4.7 B positive reaction is recorded when greefd)fluorescence is
vigible under long wave UV light. Abs ?2% of green
fluorescence under long wave UV 1igh recorded asg a
negative reaction. Under white 1la$§ ‘Sse solution may become
rose-pink if urobilin 1s present \

N
s

5.0 COMMENTS: \C) Q
PRI IAN

5.1 Contreols include positi néb 1 stain) and negative
(GH0 blank) and a subébraﬁﬁgﬁ 1 where appropriate and
available.

‘b\ \® Q

5.2 The Edelman's U{ébll st i1s one of many presumptive

tests for fe t no confirmatory testsg available for

the 1dent1§\

f@y‘al material.
5.3 The pro ctlon ?&reen fluorescent complex is indicative of
fecesq?c humans d other carnivores. Due to the presence
of ¢ rophyll, the feces of herbivores will produce an
-pink fluorescence in this test. Test resulits giving
ééls orange-pink fluorescence will be recorded as
inconclusive.

Revision 12
Cagework Analytical Methods: BI-130 5/23/12
Page 47 of 105 Isguing Authority: Quality Manager




BI-200

EXTRACTION PROTOCOLS FOR PCR DNA TYPING TESTS

1.0 BACKGROUND:

Many methods exist to obtain DNA, suitable for ampkbfication,
from a variety of sources. Caution must be exercised when
selecting an appropriate extraction method, ta g sample

quantity into account. CESD

Comey, CT et al. “DNA Extraction Strateg§;b for Amplified
Fragment Length Polymorphism Analysis ", For Sci, Vol. 39,
1994, pp. 1254-12609.

Hochmeister, MN et al. “Typing ;Ei? o§§;ib 1eic Acid (DNA)

Extracted from Compact Bone fr # J For Sci, Vol,
36, 1991, pp. 1649-1661.

Yang, DY et al. “TechnlcagDNo oved DNA Extraction From
Ancient Bones Using Si -Ba Columns.” Am J of Phys
Anthropology, Vol 104 ; 539-543,

2.0 SCOPE: éé§>

To provide appq§p K@ p cols for the extraction of DNA
suitable for ﬁ:ﬁ tlon and subseguent analyses.

3.0 EQUIPMEN@'\Q>J
O‘
QlageézBloRobot® EZ1
Qiagen EZ1 Investigator Kit and card
Centricon® Concentrator Devices
Microcentrifuge
15/50m¢ conical tubes
56/95°C heat block/oven
Fixed Angle Centrifuge
1.5m¢ microcentrifuge Tubes (1.5m{ tubes)

MicroAmp Tubes
Coarse Sandpaper, Blender, Hammer, Chisel, Drill or Dremel
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REAGENTS:

Stain Extraction Buffer {(SER)

PCR TE (TE, 10mM Tris-HCl; ¢0,1lmM EDTA, pH 8.0)
Proteinase K (ProK, 20 mg/mL)

1M Dithiothreitol (DTT)

Phenol/Chloroform/Iscamyl Alcohol (PCIAA, 25:24:1)
Ethanol (EtOH)

Phosphate Buffered Saline (PBS)

Ethyl Ether

Xylene
10% SDS &
Chelex Reagent . Qb

A\
®\

S

DNA EXTRACTION PRCOCEDURES:

0\0
NOTE: Questioned and kneocwn reference sam§§%s must be extracted

separately. If samples are extx‘ te <§n the same day,
guestioned samples should beQ@ t.

-@v

recommended amounts.
tion so samples sizes

The sample sizes listed below €§%heé§Yp
Evidence samples vary in qua a\y

may be adjusted accordingly. The\» a ghould make an effort to
retain sufficient sample f esting if possible;
however, those samples 1m |d<i> /quality may need to be
consumed {See BI-QA 5. 2%) \\

<

O A
Caution: See Comm 1]&. Q/
<\5690 o

5.1 WHOLE BLQ@%AM?Q)ES {871 EXTRACTION) :

5.1.1 Rggge ~3ul - 10p¢ whole blood into a EZ1l sample tube
ovided in the EZ1 Investigatoxr kit. Bring the volume
<2 up to 200p?¢ with Stain Extraction Buffer.

5.1.2 Proceed to 6.0.

5.2 BLOOD/SALIVA/FTA/NON-SEMEN (TISSUE, EPITHELIAL CELLS) SAMPLES
(EZ1 EXTRACTION) :

5.2.1 Place one of the following samples intc an EZ1 sample
tube: ~3mm® - lcm® cutting/portion or swabbing of samples
on cloth or porous materials (includes cigarette butts,
gum, and envelope flaps/stamps}, ~1/8 - 1/2 (~eguivalent
of previous sample size) cutting/portion of cotton swabs
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containing sample (samples deposited on non-porous objects
may need to be collected onto a swab with a small amount
of sterile deionized water, TE or SEB and the gswab cut for
testing), or ~3mm* - 5mm® portion of tissue.

5.2.2 Add the following to the tube:

190u¢ SEB
10! Pro K
Note: Large and/or absorbent substrate cuttings may
require additional SEB, up to 490 uf. ng

WO

to overnight. A 15 minute digest a °C, immediately
followed by a 5 minute digest at Béﬁ may alternatively
be performed. A\

5.2.3 Mix and incubate at 56°C for a minimu g{S% 15 minutes, up

5.2.4 Large cuttings/substrates (i Qg%p ‘Qﬁble) may be removed
by pilggyback/spin basket cé&dtri at low speed
(3,000 - 5,000 rpm) for 8?5 miQp %2/ d discarded.

5.2.5 Proceed to 6.0. QO\\ ‘&Q 0@
N O

\@ O
5.3 BLOOD/SALIVA/FTA/NO@%§@?E@§)TI E, EPITHELIAL CELLS) SAMPLES
(ORGANTIC EXTRACTIO &

5.3.1 Place one Ei}f ing samples into a sterile 1.5m!
tube: utting/portion or swabbing of samples
on cldEh <§b materials {includes cigarette butts,
gu x» nd env e flaps/stamps), ~1/8 - 1/2 (~equivalent

o revious safmple size) cutting/portion of cotton swabs
ntaining sample (samples deposited on non-porous
<2§,objects may need to be collected onto a gswab with a small
amount of gterilile deionized water, TE or SEB and the swab
cut for testing), ~3mm® - lcm® portion of tissue, or ~10up¢

- 50u¢!¢ whole blood.

5.3.1a Envelope Flaps/Stamps: Presoak the envelope flap/stamp
cutting (steam may be used to loosen the seal prior to

extraction) in 1.0m{ of sterile water at 4°C for a minimum
of 5 hours (may be left overnight). Remove the substrate
by piggyback/spin basket centrifugation and discard.
Remove all but 50ut¢ of the supernatant and discard it.
Proceed to 5.3.2 with the remaining pellet.
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5.3.1b Optional (see Comments 3): Presoak blocdstaing using
1lm{ of sterile PBS in a sterile 1.5m{ tube. Vortex
briefly, and incubate 30 minutes at RT. Vortex briefly,
then spin at high speed in a microcentrifuge for ~1
minute. Using a micropipette, remove supernatant and
proceed to 5.3.2.

5.3.2 Add the following to' the tube:

500u! SEB
151¢ Pro K

9

5.3.3 Mix and incubate at 56°C for a minimum.gﬁbl hour {may be

left overnight). It is recommended thAE non-reference
samples incubate for at least 3 hou@b hen possible.
Q\O
5.3.4 Proceed to 7.0. %)

<@
5.4 EXTRACTION OF HAIR SAMPLES QO C)OQ &

SNy
Note: For removal of hair (S)\\gbu@ﬁ@\ slide, see 9.0.

O
5.4.1 Examine the hair( d {ﬁ%?eomicroscope and note if
there is the preaggp ular material at the root
and the prese y fiuid (e.g., blood or
semen)or Oth?f ntamlnants on the hair shaft.

\\
5.4.2 Once a Qﬁbl , preferably anagen, has been
1dent1 i QE$§§; washed to reduce surface dirt and

contamana s may be accomplished by immersing the
in's e, deionized water and gently swirling.
E halr to analyzed should be washed separately in

esh watexr. Alternatively, the hair(s) may be placed in

<2K»a 1.5m¢ tube containing 1m{ 10% SDS and sonicated
briefly. Again, each hair to be analyzed should be
treated separately. If the presence of any body fluid is
noted on the hair shaft, it may be removed for separate
DNA analysis, if necessary, by soaking the hair in a
minimal amount of sterile deicnized water or PCR TE for
30 minutes. Process this extract as you would a
bloodstain (see 5.2.1 or 5.3.1).

5.4.3 Even if the hair({s) was washed prior to proceeding to
5.4.4, it may still have cellular material on its surface
that did not originate from the hair donor. Therefore,
in addition to cutting off ~0.5 - 1.0cm of the root-end,
a 0.5 - 1.0cm cutting of the shaft adjacent to the root
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may be processed geparately as a contrel, The remaining
shaft may be retained for subsequent analyses (e.g.,
microscopic exam, mitochondrial DNA).

5.4.4 To an EZ1 sample tube, containing the hair sample, add:

180pt SEB
10p¢ 1M DTT
10u! ProK

or, for organic,

Q%
To a 1.5m¢ tube, containing the hair S§§§ie, add:
5060u¢ SEB @é
20u¢ 1M DTT ‘\0
15uf ProkK {fb
<

G
5.4.5 Mix and incubate at 56°C fgr m{" f 6 hours ({may be
left overnight). \\C) N @&/

N '

5.4.6 Proceed to 6.0 fordé%, f§g%. or to 7.0 for organic
igolation. \

NS
>
> Q’b@g
5.5 EXTRACTION OF BONQ\QNB\ Q
5.5.1 Obtain \$?i<§§;1 bone and remove any tissue pregent,

u51ng(§ h (shake wvigorously with a few mis of
et olypropylene tube) or by boiling
b y. Fo lder bones, or those without adhering

ssue, clean the outer surface by sanding. For teeth,
<2{F%egin with step 5.5.2.

5.5.2 Rinse the bone/tocth, in the same manner, with distilled
water.

5.5.3 Similarly, rinse the bone/tcoth with $5% ethanol.
Finally, clean the bone/tooth with a sterile cotton swab
gsoaked with ethanol to ensure it is free of dirt and/or
other contaminants. Allow bone/tooth to air dry.

5.5.4 Crush bone/tooth into small pieces/powder with blender (a
chisel or hammer may be used initially). Alternatively,
a drill and bit may be used on large bones to create a
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fine powder. Transfer the powder and/or small pieces
created to a 1.5m{ tube.

5.5.5 To the tube, add:

500ut SEB
151¢ ProK

Mix thoroughly and incubate at 56°C overnight.

5.5.6 For EZ1 isclation, spin in a centrifuge at-low speed
(3,000 - 5,000 rpm} for 3-5 minutes, ‘ng er 200-500u¢
of the supernatant to an EZ1 sample tu nd proceed to
6.0,

For organic isolation, proceed d%;ﬁctly to 7.0,

Note: For aged bones, it may Qg ex%ssary to process
multiple samples an e extracts prior to
proceeding to quantf&lcaéjgh

5.6 EZ1 DIFFERENTIAL EXTRACTIO \Sﬁ N§§8&TAINING SAMPLES:

Note: For removal of S@gliéom @unted slide, see 9.0.
5.6.1 Place cutting/ 1§§§§§%:§%ze of sample used will be

cage dependeg? pon microscopic exam and total
sample amo Zl sample tube (the sgample may

optlona n a spin tube for ease of piggyback
centrl d ~1501¢ PBS or gterile deionized
wat e substrate to loosen cellular material
an ace at for 1-4 hours {(up to overnight).

%)

5.6.2(éghicate samples for ~20 minutes to loosen cellular
<2<~material from the substrate and perform piggyback/spin
basket centrifugation for 3-5 minutes. Without
disturbing the pellet, remove all but ~10-50u¢ of the
supernatant and discard.

5.6.2a Optional: Resusgpend the pellet and place 3-5uf on a
slide for microscopic evaluation (See BI-118). The
substrate may be discarded if the pellet contains a
sufficient number of spermatozoa; however, it may be
degsirable to add the substrate back to increase the total
amount of DNA in the sample.

5.6.3 To the remaining cell pellet and substrate (i1f present)
add the following:
Revisgion 12

Casework Analytical Methods: BI-200 5/23/12
Page 53 of 105 Isguing Authority: Quality Manager




120p¢ SEB
10p¢ Pro K

Note: Large and/or absorbent substrate cuttings may
require additional SEB, up to 490 pt.

5.6.4 Mix and incubate at 56°C for 15 minutes to a maximum of 1
hour.

5.6.5 L.abel a new EZl sample tube. Remove gubgtrate (if
present) by using piggyback/spin basket cq?%rifugation
and disgcard. A final centrifugation o gh speed for 21
minute may be performed to further so IEélfy the pellet.

5.6.6 Remove all but ~10-50p¢ of the su hatant, taking care
not to disrupt the cell pellet M@} he bottom of the tube.
Transfer this supernatant (epi \gl cell fracticn) to

the new, labeled sample tubeb‘and re at 4°C or proceed
directly to 6.0.

5.6.6a Optional: The purp of del rentlal extraction is,
typically, to obtai ion that is wvoid of any
epithelial contribut on \» tances in which there is
an overwhelming qé& eplthellal cells to sperm
o} 1ca11y, steps 5.6.3-5.6.4

that appear i Q%
n

may, at the ‘<§§hscretlon, be repeated 1-2 times
These additiocnal

prior to p e
supernata@ d@(}lcég’ed to be retained.

5.6.7 Wash té§ g%] Qﬁﬂet as follows: Resuspend the pellet in
500 PR3 4%’cexzng briefly. Spin in a
mig¥rocentrifu for ~5 minutes at maximum speed
10,000rpm). Remove all but ~10-50uf¢ of the supernatant
<2{, nd discard it. Note: 1000u{ PBS should be used for
500u¢ sample volumes.

5.6.8 Repeat 5.6.7 1-5 more time{s). In instances of low sperm
amounts, additional washes are recommended. The final

wash performed is to be done usging sterile delonized
water,

5.6.8a Optional: Resuspend the pellet and place 3-5u¢ on a
slide for microscopic evaluation (See BI-118). If intact

epithelial cells remain, the pellet should be redigested
(5.603 = 506.8}-

5.6.9 To the remaining sperm pellet solution add:
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180u¢ SEB
i0pt¢ 1M DTT
10p¢ ProK

Note: up to 490un¢{ SEB may be used

5.6.10 Mix and incubate at 56°C for a minimum of 15 minutes (may
be left overnight).

5.6.11 Proceed to 6.0 (note: extract will first need to be

transferred to an EZ1 sample tube if a spgg tube was used
originally) . <<D

~\
o
5.7 ORGANIC DIFFERENTIAL EXTRACTION OF SEM%ﬁEaONTAINING SAMPLES ¢

Note: For removal of sample from maéhte glide, see 9.0.

5.7.1 Place cutting/sample (the g% ﬂﬁ}e uged will be
case dependent and based @pon pic exam and total
sample amount} into a rl tube and add ~150u¢
PBS or sterile delo gitate the substrate to
loogen cellular ma ce at 4°C for 1-4 hours

(up to overn1ght \»

5.7.2 Sonicate sampé(g f&\ %Y lnutes to loosen cellularx

material f ate and perform piggyback/spin
basket ce &ghtl or 3-5 minutes. Without

distur }S>t , remove all but ~50u¢ of the
SuPefiﬁlanE> QQD scard

5.7 ’%ptlonal uspend the pellet in the remaining 50p¢
cfgg’place 3-5ut on a slide for microscopic evaluation

<2‘<~ See BI-118). The substrate may be discarded if the
pellet contains a sufficient number of spermatozoa;
however, it may be desirable to add the substrate back to
increase the total amount of DNA in the sample.

5.7.3 To the remaining cell pellet and substrate (if present)
add the following:

500u{ SEB
15p¢ Pro K

5.7.4 Mix and incubate at 56°C for 45 minutes to a maximum of 1
hour.
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5.7.5 Label a new sterile 1.5m¢ tube. Remove substrate (if
present) by using piggyback/spin basket centrifugation
and discard. A final centrifugation on high speed for 21
minute should be performed to further solidify the
pellet.

5.7.6 Remove all but ~50u! of the supernatant, taking care not
to disrupt the cell pellet in the bottom of the tube.
Transfer this supernatant (epithelial cell fraction) to
the new, labeled sterile tube and store at 4°C or proceed
directly to 7.0. (%)

@

5.7.6a Optional: The purpose of a differe f&al extraction is,
typically, to obtain a sperm fracti I%1’1&\&: ig void of any
epithelial contribution. 1In 1nstan g in which there is
an overwhelming proportion of epitHelial cells to sperm
that appear intact microscopic , steps 5.7.3-5.7.4
may, at the scientist’s dlsc be repeated 1-2 times
prior to proceeding to 5.74 additional
supernatants do not needQSo beciétqsn d.

O

5.7.7 Wash the sperm pelle (SB fqg} Resuspend the pellet in
1000p¢ PBS by vorte ng hgﬁe Spin in a
microcentrifuge f at maximum speed

{>10,000rpm) . R» ov Lké¥;.~50p€ of the supernatant
and discard lt

O
5.7.8 Repeat 5 1— \mor ime{s). In instances of low sperm
amount @ ashes are recommended. The final
wash ﬂ%) o be done using 100Cut¢ sterile

del 1zed

Qé?Optlonal Resuspend the pellet in the remaining 50ul
place 3-5uf on a slide for microscopic evaluation (See
BI 118) If intact epithelial cells remain, the pellet
should be redigested (5.7.3 - 5.7.8).

5.7.9 To the remaining sperm pellet soclution add:

500u¢ SEB
20p¢ 1M DTT
15p¢ ProK

5.7.10 Mix and incubate at 556°C for a minimum of 2 hours (may be
left overnight).

5.7.11 Proceed to 7.0,
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5.8 CHELEX EXTRACTION:

Note: Chelex may also be used for clean-up of sampies that
have already been extracted to remove

contaminantg/inhibitors as needed. Start with step
5.8.4.

5.8.1 Place a ~3mm® cutting of a bloodstain, or 3u¢ whole
blood into a sterile 1.5mf{ tube and add imi{ of sterile

deionized water. &
0
5.8.2 Incubate at RT for 15-30 minutes wit ccasional mixing
or gentle vortexing. CESD

5.8.3 Spin in microcentrifuge for 2- i? inuttes. Remove all
but 20-30u¢ of the Supernatan@\and discard it, If the
sample is a bloodstain, le t ubsgtrate in the

tube. << C)O &
5.8.4 Using a wide bore pi %?e t@, § tip with the end

cut off, add 200ut sh?{~ QﬁSéQred 5% Chelex (0.5g
Chelex re81n/10m€<2ter pure water}. Make gure
the Chelex soluky n %E§iﬁlxed before adding to the
sample.

5.8.5 Incubate at C 30 minutes.

5.8.6 Vortex &bh &for 5-10 geconds.
5.8.7 Incuéﬁ:e@ﬂ\ ng water for 8 minutes.,

5.8.8 Qértex at hg;L speed for 5-10 seconds, followed by
C§chntrifugation at high speed (2 10,000 xpm) for 2-3

<2K minutes., This extract may be taken directly to real

time PCR (see BI-207) for quantification of the DNA.

Note: Care must be taken to not disturb the Chelex resin when
removing sample for subsequent procedures. After
storage and prior to sample removal, repeat step 5.8.8.

6.0 BIOROBOT EZ1l ISOLATION PROCEDURE

Note: The BioRcbot EZ1l may also be used for clean-up of samples
that have already been extracted using the organic
procedure to remove contaminants/inhibitors as needed.
Transfer the extract to an EZ1 sample tube, bring the
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volume up to 200pf{ with Stain Extraction Buffer, and begin
with step 6.1.

6.1 Insert the Investigator Card into the card slot on the
BioRobot EZ1l {if not already in place} and turn the instrument

on, Note: the card may be left in place when the instrument
is turned off.

6.2 Press “Start” to display the protocols menu and choose one of
the following protocols:

Choose “1” for the “Trace” protocol if no subs te is
present in the sample tube. ‘63

Choose “27 for the “Tip Dance” (Trace T?%Sé?otocol if the
substrate 1ls present in the sample tub

Choose “4” for the “Large Volume” §§§?ocol for 500 ul sample
volumes. Note: Step through thec$' egarding additional

‘MTL’ Buffer. Q)
6.3 Press “2” to elute in TE. (')® C)Q/é&
¥ N

6.4 Select either the 50u¢ ogzthe\gb lution volume from the
menu {option 1 or 3, rgg@ec The 50u¢ elution may be
preferable for FTA, &éﬁuteéﬁamQ} , or those suspected to be
of low DNA concentrapfio \gquz? 00u!¢ elution velume may be
preferable for ai§aleséax ing potential irhibiticn.

6.5 Press any k c%; \\Zhrough the text displayed in the
LCD, Wthhé%“ gﬁs\yo rough the following steps to load the
1nstrum§E§

6.6 Open (5@ workstatlon door.

6.7 Eﬁ%mine the reagent cartridge(s) for the presence of
precipitate. Invert each cartridge to mix the magnetic
particles then tap the cartridge(s) to deposit the reagents
to the bottom of their wells.

6.8 Insert the appropriate number of reagent cartridges (1-6 per
extraction run) into the cartridge rack, snapping them into
place. Additional samples (beyond 6) can be accommodated in
subsequent instrument runs. Place the loaded cartridge rack
into the instrument, followed by the tip rack,

6.9 Load 1-6 tip holders containing filter-tips into row 2 of the
tip rack.
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6.10 Load 1-6 opened and appropriately labeled elution tubes into
row 1 of the tip rack. Make sure that the tube order matches
that of the sample tubes.

6.11 Load 1-6 opened sample tubeg from step 5.0 into row 4 of the
tip rack.

6.12 Close the workstation door.

6.13 Press “Start” to start the extraction protocol.
9
6.14 When the protocol ends, the LCD displays “Rngg%col finished.*
To run another protocel, press “ESC” to nggkn to the
protocols menu. Otherwise, press “StoQ§§bwice to return to
the first screen of the LCD.
.\Sb

6.15 Open the workstation doox. Remove{é%ﬁ cap the elution tubes
containing the purified DNA. Digégrd e cartridges, tip

holders/tips, and sample tubesQO C)O &

6.16 At the completion of all r\ug)?fo@\h
tool {option #3 from the.(¥ olgg\s
adaptor, tip rack, cart¥idg Zac

instrument with 70% Est\'@)anoxofégwed, optionally, by

nanopure water. XSD’ e} <:>
CE> ~§S§ {ﬁg
6.17 Switch off the\é@t% n&{/& aving the Investigator card in

place. Qo)
\6 O(\ NV
6.18 Proceed tq§rea (bim R (see BI-207) for guantification of
the pug\'ied ined in step 6.15.
@K

7.0 ORGAN%?K IFICATION PROCEDURE:

Note: For most stains the cuttings/substrate will not interfere
with organic extraction and need not be removed prior to
proceeding to 7.1. Larger cuttings/samples can be removed
by piggyback/spin basket centrifugation at low speed
(3,000 - 5,000 rpm) for 2-5 minutes and discarded.

Proceed to 7.1.

7.1 In a fume hood, add 500u! phencl/chloroform/iscamyl alcohol
(PCIAA) to the extract. Mix vigorously by hand to achieve a
milky emulgion. Spin in microcentrifuge for 3-5 minutes to
achieve layer separation.
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7.2 If the agqueous phase 1g clear, If it is not

clear (e.g. cloudy or large or ‘dirty’ interface),
the aguecus layer to a fresh sterile 1.5m!{ tube

proceed to 8.0,

transfer

Repeat 7.1
1-2 times until the interface i1s clean and agueous phase ig
clear. Proceed to 8.0.

8.0 ISOLATION VIA CENTRICON CONCENTRATOR DEVICE:

Note: Centricon concentration of gamples with high DNA

concentrations will be performed separately from those with
low DNA concentrations, )

O@

8.1 Assemble a Centricon-100 unit according tocéhe manufacturer's
directions and label the unit. CESD

8.2 Add 1.5m¢ of TE to the upper Centrlce§;ﬁ00 reservoir,

8.3 Add the entire agueous layer

aa&? ly 5001¢) to the
upper reservoir containing TE he phenol mixture
{(including substrate if presen

organic waste
container in the hood. DisQék ﬁ%y:uato a biohazard
waste container. §§>

8.4 Cover the Centricon t

etentate cup. Spin in a
fixed angle centr%éz {E%S» RQB rpm for 10-20 minutes, The
DNA sample will be<¢on

ed in ~20-40puf{ of TE in the
upper Centrico 1le molecules with molecular
welghts of 1 th ]{l/ 00 daltons will pass through the
filter. s\\ O

Note: Th§§0ent nlts are gsensitive to rotor forces.
centrif

Do
e above 2000 x g.

Centrifugation time can
e increased if the volume does not reduce to £40u!¢ in
<2{$> the gpecified time.

8.5 Add 2m!{ of PCR TE to the concentrated DNA solution in the

upper Centricon regervoir and repeat the centrifugation step
as in 8.4. Di

Digcard the effluent that has collected in the
lower reservoir.

B.6 Repeat 8.5 for a total of 3 washes

8.7 Invert the upper reservolr onto the retentate cup provided

with the unit. Centrifuge at ~2500 rpm for 2 minutes to
transfer the DNA concentrate into the cup
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8.8 Estimate the volume of the concentrate using a pipette to
transfer to a labeled sterile 1.5mf tube. Proceed to real
time PCR (gee BI-207} for guantification.

9.0 REMOVING MATERIAL FROM SLIDES:

9.1 FREEZING:

9.1.1 Place glide in -20°C freezer for 3-5 minutes.
9.1.2 Wearing safety glasses, pry the cover s%ﬁbtaff.

9.1.3 Add a drop of xylene to dissolve the<ﬁ%ﬁnting medium.

%
9.1.4 Remove the hair and soak in 10-20m¢ xylene for 2-3
minutes to remove residual mou g medium.

Q

Note: Sperm-containing glides are @3 with sterile
deionized water at thls suitable volume
(~100pn¢) of stain extr may be added
directly to the slid C)In minutes at RT and
then by pipetting nd{\ W ash the sample off of
the slide and tran 1 sample tube or a 1.5m¢{
tube. Repeat 3xébt1 acgtéroceed to 5.6.3 or 5.7.3.

9.1.5 Rinse the haf%? \é? <;>absolute ethanol to remove
the xylenQ> Qg c to hair extraction under 5.4.

O(\ O\/
9.2 SOAKING IN &Lﬁg\ Q)

9.2.1 the Sl in xylene for several hours until the
over slip can be slid or pried from the slide.

<2 Note: This will likely remove markings from the slide.

9.2.2 Remove the hair and soak in about 10-20m¢ Xylene to
remove the residual mounting medium.

9.2.3 Rinse the hair briefly in absolute ethanol to remove
xylene and proceed to hair extraction under 5.4.

10.0 DNA EXTRACTS:

10.1 After a sample has been extracted and during subsequent
analyses (i.e. quantification and amplification), the DNA
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extract may be stored at 4°C. For longer storage periods, the
extract should be frozen at approximately -20°C. These
extracts are in-progress work product during this stage(s).

10.2 Any extract remaining, following the completion of analysis

will be retained in the corresponding case DNA packet (See
BI-102),

11,0 Comments:

11.1 These methods employ the use of phenol that isQ@ strong
organic acid and may cause gevere burns in ad lon to other
effects. All operations with these chem1ca¥§bshou1d be
performed in the hood with appropriate p tive gear (gloves,
lab coat and eyes protected by hood shle and/or gogglesg) .

11.2 An appropriate reagent blank {for eega type of extraction)
will be carried through all extraq@@on eps to check the
purity of the reagents being u <igy efneed only be one
reagent blank per extraction i ic¢h the same lots of
reagents are used. It 1is () ec o have a separate
blank for each case that n\e t the game time. When
extracting a batch of =a les tiple EZ1l Robots, a
single reagent blank bee\\ Q;Eov1d1ng the instruments
are running concurr nal reagent blanks will be
incorporated when t s ber exceeds the capacity of

available instr &hts CD g subsequent runs), so that one
blank is inclu% %zrun

N\
11.3 Presoaking(§&9:$$géi¢é;21th PBS may help to prevent
1

inhibitiqa;of a &5%;ation by heme products, particularly
when a ing DNA\gbtained from samples of "heavy"
blood ins (e.g. control blecodstains).

11.4 Tﬁé%e procedures represent the 'usual' protocol for a given
material; however, any of these different extraction methods
are suitable for all biological materials, though minor
modifications may be necessary.
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BI-207

DNA QUANTIFICATION: REAL-TIME PCR

1.0 BACKGROUND:

9

DNA methodclogies that employ the PCR, such as Sxéaénalysis,
necesgitate consistent guantification of humanﬂ‘ A to obtain

optimum data. CESD

Green, R.L., et al, "Developmental Valida'ﬂ&h of the Quantifiler™
Real-~Time PCR Kits for the Quantificatio@} f Buman Nuclear DNA
Samples," Journal of Forensgic Scienceﬁdzbl. , No. 4, pp. 805-825.

O .o
Crouse, €., et al, “Improving Effi ggn £ Q%éﬁall Forensic DNA
Laboratory: Validation of Robot@ss& valuation of
Microcapillary Array Device,” at d2d 05, Vol. 46, No. 4, pp.
563-577. A\
x@ O OC)
Quantifiler™ Kits (Quqif@ié&iﬁm ngan DNA Quantification Kit and

OQuantifiler™ Y Human K%%;ntification Kit) User'’'s Manual,
Applied Biosystems (V7 &

q O(\ N
7500/7500 Fast Qéa @ne& Systems Maintenance Guide, Applied
OO Q

Biosystems.

2.0 SCOPE: @é‘

To pnaggae a reliable method for the consistent quantification of
small “amounts of human DNA isolated from forensic samples.

3.0 EQUIPMENT/REAGENTS:

ABI 7500/Computer 96-well Reaction Plate

ABI 7500 SDS Software 96-well Reaction Plate Base
Pipettors Optical Adhesive Covers
Pipette Tips Centrifuge (optional)
Quantifilerm Human Kit Microcentrifuge Tubes

20 ug/mt Glycogen {(optional) PCR-TE
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4.0 PROCEDURE:
4.1 PREPARATION OF DNA STANDARDS:

4.1.1 Label 8 sterile microfuge tubes A through H or 1-8,

4.1.2 Dispense 30u¢ (or adjusted amount according to the kit
QC results: Form 419-0C) of PCR-TE into tube A (Std.
1) and 20u! of PCR-TE into tubes B-H (Std. 2-8).

4.1.3 Mix the Quantifiler Human DNA Standard roughly by
vortexing 3-5 seconds. Transfer 10p{ e tube A (Std.
1) . Mix the dilution thoroughly. <é

4.1.4 Prepare Std. 2-8 via a serial difﬁkion by mixing and
subsequent 10p¢ transfers frowssﬁbes A through H. The

dilution series consists of ;7 16.7, 5.56, 1.85,
0.62, 0.21, 0.068, and 0.0{@ , respectively.
@)
4.2 REACTION PREPARATION: @Q \C) é&

. 0 @
4.2.1 Determine the numbéié}f @p&ﬁ be quantified

{including, at mindmum %) of DNA standards) .
& O

4.2.2 Fill out the ngo Léyd.gzé;? (Form 206-BI) on the ‘Plate

Setup’ tab qgé preadsheet/template. Print a
copy for Chooge the ‘Plate Document’
tab an su Q\t éﬁnformatlon ig correct and
corr Load Sheet information entered.
Per%%r g’ of the Plate Deocument Worksheet to
\§ & drive) for subsequent transfer to the ABI
cu

The ment must be gaved as a .txt file.

Q@
QF) Calculate the volume of reaction components needed,
<2 based upon the number of samples to be quantified and
adding 2 or 3 reactions to compensate for loss and
variability due to pipetting. The following are the
volumes needed per reaction.

Quantifiler PCR Reaction Mix 12.5u¢
Quantifiler Human Primer Mix 10.5ut

Note: The volume of reaction components necessary to
prepare the Master Mix will be automatically
calculated upon Load Sheet data entry.
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Thaw the primer mix and vortex 3-5 seconds. Pulse-spin
prior to opening the tube. Mix the PCR Reaction Mix by
gently swirling the bottle prior to use.

Place a 96~well reaction plate into a base, being careful
not to touch the top or individual wells. Do not place
the plate directly onto the counter or any surface other
than its base or the ABI 7500 thermal block.

9

Prepare the Master Mix by pipetting the quired volumes
of primer and reaction mixes into an ropriately sized
microcentrifuge tube. Mix by vort g 3-5 seconds,
fellowed by a pulse-spin.

.\Sb
Carefully pipet 23uf{ of the PGRVMagter Mix into the
bottom of each reaction wel ng ugsed., ‘Blowing-out’
the pipette is not recom a(sld splashing and/or
bubbles in the well. é

Add 2pt of sample é}t the appropriate
reaction well, bezgg avoid bubbles as much as
possible. \ \ O

Seal the rea%on@ %th an Optical Adhesive Cover.

Proceed tQQ é

4,3 RUNNING T}é\RE QS.)ONC'O

4.3, léﬁbr on théC)SOO computer and login with the appropriate
S

QK

er name and password. After the computer has
completely started up, power on the 7500 instrument,
allowing if to warm up at least ~30 geconds. Launch the
ABI 7500 8DS Software.

4,3.2 Open the instrument tray by pushing on the tray door.
Place the plate into the tray holder so that well Al is
in the upper-left corner and the notched corner of the
plate is in the upper-right corner.
4.3.3 Close the instrument tray by gently pushing the right
side of the tray door.
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4.3.4 In the 8D8 software, sgelect File>New and choose Abgolute
Quantitation for Assay, 96-Well Clear for Container, and
Quantifiler Human for Template.

4.3.5 Import the previously saved plate document by selecting
File>Import Sample Set-Up. Browse to locate the saved
.txt file and choose OK.

4,3.6 Review the plate document to ensure the appropriate
detectors and tasks have been applied to each sample.
Change the task for any unused wells todg?c in View>Well
Inspector or by highlighting and doublg jclicking on a
well (s). Make any other changes, asx' cegsgary. Select
the Instrument tab and review the tflermal cycler
conditions [Stage 1: 1 cycle, 95(&510 00 min.; Stage 2:
40 cycles, 95°C, 00:15 min, 609, c')1 :00 min.; 25uf¢ sample
volume; 9600 emulation; Data{p llection: Stage 2, Step
2 (60.0@1:00}]

Quantifiler nual (page 2-11) for
1nstructlon detectors if needed.

Note: Detectors are cr e initial
instrument seg’ usage Refer to the
onségéaéb

4,3,7 Save the pl a .sds file with the

n
approprlate at\\é n@

4.3.8 Under sé}ﬂm tab click Start to begin the run.
Whens\ '{Pﬂ ®6mpleted proceed to 4.4.
\5(\ @)

4.4 ANALYE;SéhND RES&E&S‘
ézqgﬁ?cmen the plate document to be analyzed.

4.4.2 Select Analysis>Analysis Settings and verify the
settings are set as follows: All for Detector, Manual
Ct, 0.200000 for Threshold, Manual Baseline, 3 for
Baseline Start (cycle), and 15 for Baseline End (cycle}.
Click OK.

4,4,3 Select Analysis>Analyze.

4.4.4 In the Resgults tab, select the Standard Curve tab and
choose Quantifiler Human as the detector. Review the
data for inconsistencies from the following:
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An R? value of >0.99 indicates a close fit between the
standard curve regression line and the individual Cgp
data points of quantification standard reactioms.

An R* value of <0.98 needs further analysis of the
standard curve for problems. Refer to the Quantifiler
Kits User’s Manual (page 5-6) for troubleshooting
guidelines.

The slope should fall within the typical slope range of
-2.9 to -3.3. A siope of -3.3 indicate%£%00/

amplification efficiency.
P Y ~$Sb
4.4.5 Select the Amplification Plot tab Q§ the Results tab)
and choose either the Quantifile man, or the IPC

detector. Ensure the Threshold\¥s set to 0.20 before
proceeding (Note: the thresgh bar will be green if the
data has been analyzed and d «?iﬁnalysis ig needed) .
Highlight the sample(s €D in the table to view

the associated plot(s plots for both
detectors for amp11ﬁ§§b 10@5 n inconsistencies.
O
4.4,6 Select the Compoﬁgé &é& baﬁn the Results tab. The
halogen lamp m ee ement 1f the dye signal
lines contai i o pear wavy/unstable and/or if
the Rox valu %\; roaching or has fallen below

500. Seeyfgﬁ Qﬁ it is important to use the
game s v& &h time.

4.4.7 In gge ﬁé?t (:%, select the Report tab and highlight
' sambi%%:itbf interest to view the results, Review
Qggg Qty co n to determine the amount of DNA present in
each sample. Review the Internal Positive Control (IPC}
Cr value for each sample. It should fall within a range
<2 of 20-30. If the value i1s >30 for a particular sample,
there may be an indication of inhibition.

4.4,.8 Export the report. Within the report tab, select
Tools>Report Settings and check the appropriate boxes to
be displayed in the report and click OK. Print a copy
of the Standard Curve for the case record. Select
File>Export to export the report {e.g. to USB drive) as
a .csv file.

4.4.9 Open the 7500 Results Sheet (Form 209-BI) template in
Excel. Import the .cgv file into the Raw Data tab of
the worksheet. Choose the Results tak and review the
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imported data. Delete any unused wells from the sheet.
Adjust values in the Final concentration and upyl Sampie
for Dilution columns. Print a copy of the results sheet
for the case record. Perform a ‘Save As' prior to
exiting the template.

5.0 COMMENTS:

5.1 Refer to the Quantifiler Kits User’s Manual for specific
thermal cycler conditions, additional user information, and
troubleshooting guidelines. ng

5.2 If the Component Dye signals appear unst ‘é and/or Rox
values approach 500, the Halogen Lamp may) be checked
manually to determine if replacement E%heeded Place the
Green Calibration Tray in the block.\“Select Instrument >
Calibrate and set the exposure ti q%o 40%6ms, lamp control

to Max, and gelect Filter A, shot and observe
results. Expected results sh <:§b z{kof red
fluorescence displayed in a %a of fluorescence

indicates the need for la epxg ééz. The lamp status
should be checked as we ;f§§ag Instrument > Lamp

Status/Replacement and 1ew ?ﬁ) ondition.

5.3 In order to exten%{é’e G\Je @ he Halogen Lamp, the
instrument should f anytime it is not in use.

Lamp life is a,%@ox,k@:e e%000 hours.
é(b O(\ O\/é\
s\ \)(\ Q)%
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BI-208

STR AMPLIFICATION: PP16HS

1.0 BACKGROUND:

DNA analyses have revolutionized forensic biolegy. The
advent of PCR allowed scientists to begin ana ing
evidentiary material present in minute quansities and
degraded states. The identification of é nsically
sigrificant STR loci allows scientists combine the
discrimination attainable with the oL%éS RFLP technology
with the gpeed and sampling capabilifNes of cother PCR-based
methodologies. The PowerPlex™ 16 ksgws the co-
amplification of the core CODI f@ well as,
Amelogenin, and two pentanuclgatl 1oci, Penta D

and Penta E. \\ &/

NS
Butler, J. Forensic DNA pkgsg58€§£29y and Technology
Behind STR Markers. Press.

PowerPlex 16 HS S&§ Qéé}f%;al Manual

2.0 SCOPE:

B O(\ \/
To provide dé? {:§B thod for consigtent, high guality
ampllflca n of om forensic samples ensuring the

generatk% of sult e PCR product for capillary
elect oresig and analyses of these STR loci.

3.0 EQ IPMENT/REAGENTS:

BioHood

10% Bleach or Dispatch®

Uv light

Thermocycler

Microcentrifuge

MicroAmp tubes

PowerPlex 16 HS Kit Contents
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4.0 PROCEDURE:

4.1 DNA TEMPLATE:

4.1.1 Based upon the quantity of DNA isolated and its
initial concentration, the scientisgt should have all
samples at an optimal concentration for amplification
(e.g., 0.1lng/ul¢-0.4ng/p¢). It is also convenient to
have all samples that are to be amplified at the same
time to be at the same concentration if possible for
ease in the preparation of PCR Master Mi% and reaction
additiong. The maximum amplification\ ume for low
level or undetected samples is 17.5 for PowerPlex 16
HS. For larger volume samples, it~fday be necessary to
concentrate the sample prior to.awplification. The !
analyst may alsc choosge to er%&ét, quantify, and :
combine additional sample pé§p 'Ef amplification as an
alternative.

4.1.2 The amount of DNA temp e égd an amplification
reaction should be agget .5-1.0ng but may be
adjusted if neceq&?éb

Q)
4.2 AMPLIFICATION SET-UP \@ \Qs\ OC)

D
4.2.1 Determine th <?/ samples to be amplified and
label mi QS' Eub 200U} for identification.
4.2.2 Thaw bgé 16 HS 5X Master Mix, PowerPlex 16
t§x §:§herC?y1r Mix, and Amplification Grade Water

@tlon

4. 2<Q§%alculate the volume of reaction components needed
K based upon the number of samples (including extraction
<2 and amplification controls) to be amplified and adding
1 or 2 reactions to compensate for loss and
variability due to pipetting. Use Form 210-BI for
recording this information. The following is a list
of the 'fixed' amounts to be added for a 25ut

reaction,

PowerPlex 16 HS8 5X Master Mix Supt
PowerPlex 16 HS 10X Primer Mix 2.5u¢
DNA Template + dH;O 17.5p¢
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Note: The amount of reaction mix added to each sample is
dependent on the volume needed to add the DNA
template.

4.2,4 Prepare the reaction mix by pipetting the reguired
volumes of 5X master mix, 10X primer mix, and water
(if needed) into an appropriately sized
microcentrifuge tube. Mix thoroughly and pulse-spin.

4,.2.5 Pipette the appropriate amount of reaction mix into
each microAmp tube. The negative amplifGration
control should be the last sample prQ\ sed.

~\

4.2.6 If DNA concentrations were not tzifgéme, add

appropriate volume of dH,0 as necessary.

4.2.7 Pipette each DNA sample into{ﬁ?e appropriate tube.
Only the tube to which the being added should
be opened at this time qg <i§b DNA-containing
tube should be open at y t i%g h the exception of
the negative control\ﬁhlc open throughout the
co

process). Use 28 for the positive
amplification control for the negative
amplification oé%&rd\ in, making additions to the
negative co t

the sa cler positions on Form 210-BI.

4.2.8 Ensureg@ % are closed tightly and record

4.2.9 Rem co and touching only the rack/MicroAmp
Ve tfgh the gamples to the thermal cycler in

Qgﬁg.Amp/Po mp room, using the other hand on the door
(Q nobo.

£22.10 Place the samples into the thermal cycler. Do not

set the rack down in this rcom. Remove/discard gloves
and return the rack to the main biology lab.

4.3 THERMAL CYCLING PARAMETERS:

Select the pre-programmed 'ppl6HS' thermal cycling profile
with the following conditions:

96°C for 2 minutes, then:
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ramp 100% to:

94°C for 30 seconds,
ramp 29% to:

60°C for 30 seconds
ramp 23% to:

70°C for 45 seconds
for 10 cycles, then:

ramp 100% to:
g0°C for 30 seconds

ramp 29% to: ng
60°C for 30 seconds gS)
ramp 23% to: {é
70°C for 45 seconds %Q
for 20 cycles, then O

N\
60°C for 30 minutes, then: Q§§b

S

4°C soak Q C)Oé&

5.0 AMPLIFIED DNA PRODUCT: <2 \:§§>
5.1 After cycling has con§$3ﬁ dﬁ$> ngbsamples from thermal

cycler. Samples s n the Genetic Analyzer as
gsoon as p0551bl cation. Prior to capillary
electrophore31 iéér analysis is completed the
gamples may b proximately 4°C. For longer
storage penggé should be frozen at approximately
-20°C. Ampi ﬁ<3 Qﬁ) ct is ONLY stored in the Amp/PostAmp

room. @ O

5.2 At %qﬁélnt in time after STR analysis is completed (i.e., case
ﬁ§§§ een reviewed and report approved}, the amplified product
wlll be disposed of in a biochazard container in the amp/post-
amp room., As needed, this container will be sealed and
transported directly to the dishwashing room. The container
will be placed into a second bichazard bag, sealed and
disposed of with other biohazardous material.

6.0 COMMENTS:

6.1 Clean surfaces with freshly made 10% bleach sclution or
Dispatcthrior to set-up.

6.2 Wear gloves at all times during ampliification set-up.
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6.3 Mix all reagents thoroughly (e.g., vortex) and pulse-spin
them in microfuge prior to dispensing.

6.4 After initial thawing, the 2800M DNA standard and any
dilutiong will be stored at approximately 4°C.

9
©

@"’é

&
S
& & o

N\
0 . O K
AR
&‘)Oo(\\(/(’
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BI-210

STR TYPING: CAPILLARY ELECTROPHORESIS AND DATA ANALYSIS

1.0 BACKGROUND:

Any eukaryotic genome is interspersed with repeate QﬂNA gequences
that are typically clasgified by the length of t core repeat

sequence, and the range of contiguous repeats cally seen or
the overall length of the repeat region. hort Tandem
Repeat) loci are scattered throughout the genbme occurring every
10,000 nucleoctides or so, and have core ’ at units of 2-6bp in

length with overall lengths of less th

STR loci examined for human ident1 SatngS% oses were selected
for the following characterlstlcsqbl crlmlnatlng power
(generally >0.9) with observed of »>70%, 2) loci on
separate chromosomes to av01 Q<§§$b111ty to obtaln
robust, quality, reprodu01 ltiplex amplification is

performed, 4} low stutte 1on rate and 6) small
allele gizes (<500 bp) c§§z>e@§§' nt of analysis of degraded
samples. O &

O
By 1997, as the a cotmunity-wide forensic science
effort, the fol 1n (I loci, all tetranucleotide repeats,

were selected Q tQ? for NDIS, the CODIS (COmbined DNA Index
System) Nat’Qﬁﬁl B} q%;& D3S81358, THO1, D21S11, D18S51, D55818,
D135317, DQ§B20, DleS5 CSF1PO, VWA, D8S1179, TPOX, FGA. When
all 13 S core locl were examined, the average random match
proba 1ty was found to be <1 in 1x10"® among unrelated
individualg, offering the promise of individualization.

In addition to the 13 core CODIS loci, the PowerPlex™ 16 HS
multiplex includes Amelogenin, a gender ildentification locus, and
two pentanucleotide repeat STR loci, Penta D and Penta E. STR
typing, with amplified products generated from this kit, separated
by capillary electrophoresis on the 3130 Genetic Analyzer with
data collection and analysis software employed in developing the
genetic profiles, will be used to produce STR preofiles from
evidentiary material for entry into CODIS.
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Butler, J. Forengic DNA Typing: Biology and Technology Behind
S8TR Markers. (2001) Academic Press.

GenePrint’ PowerPlex™ 16 System Technical Manual
ABI 3130/3130x1 Genetic Analyzer Getting Started Guide

ABI 3130/3130xl Genetic Analyzer Mainenance Troubleghooting
and Reference Guide

GeneMapper™ ID Software User Guide ng
.\Sb
2.0 SCOPE: A

To provide a reliable method for genera STR genetic
profiles from forensic casework and of der DNA dztabase

gsamples. <>
\Q Q*

3.0 EQUIPMENT/REAGENTS: Q

3130 Genetic Analyzer with D 4; C eigégn Software

GeneMapper™ ID Software \\
Computer ng
Heating Block (or 9700qggg \l ¢
Benchtop Cooler S)
Capillary Arrays

Syringe \O &Q/
96 Well React epta
Buffer Reser

POP4 Polymer()
Genetic A yzer €§g}
PowerPl 6 HS Ki ntents
Power%ﬁéx® 16 HS Matrix Standards
Dei ed Formamide
Nanopure Water
4.0 PROCEDURE:
4.1 AMPLIFIED FRAGMENT DETECTION USING THE 3130

Note: Prior to using the ABI 3130 Genetic Analyzer for
gamples, a spectral calibration (matrix standards) must be
run to achieve proper color separation of the dyes used for
the amplification primers, allelic ladders and size
standard. To prepare a matrix, four standards are run
under the same capillary electrophoresgis conditions that
will be used for samples and allelic ladders. Use the 3130
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Matrix Standard set, which includes the Fluorescein Matrix,
JOE Matrix, TMR Matrix and CXR Matrix for the blue, green,
yellow and red matrix standards, respectively. This is
performed when necegsary due to performance, or after any
instrument maintenance/repair that involves
adjustment/replacement of the CCD camera or laser.

Additionally, a Spatial Calibration must be performed prior
to running any samples. The instrument uses ilmages
collected during the spatial calibration to establish a
relationship between the signal emitted for e(ggbcapillary,
as well as the position where that sgignal fa and is
detected by the CCD camera. This is perfo any time a
capillary is installed or replaced (inclESan temporary
remcval of a capillary) or if the 1nstﬁ5 t is moved.

start Data Collection 8 nd wait for green
sgquares to appear fon<§ tions on the
service console. essary subfcldexs

on the left tree e OQSD&@ ollection. Refer

4.1.1 Turn on the computer, tux \SEe instrument,

to the ABI 313048230 1$b ¢ Analyzers Getting
Started Guide r daggi instructions on

ingtrument s&ga \$}n ing creation of
instrumen Xé?gqggb
calibrati u%g

z&c

esults groups, and spatial
the 3

appropriate information in
tion Log {(Form 422B-QC).

>
S d\gﬁ Cls Q\fformed in the opposite order
1on software, 3130, then computer).
P
he D lection Software must be closed by
<
\ h0081ng Stop All’ and waiting for all red
(Q gsymbols to appear before closing. Never use the
<2{$> ‘X' to close while green or yellow symbols are
displayed.

4.1.2 Create a new plate record:

4.1.2.1 For a spectral calibration plate, expand
the tree pane of the Data Collection
Software and click ‘Plate Manager,' undex
‘ga3130xl’. Choosge '‘New’, and f£ill in
the dialog boxes, with ‘Spectral
Calibration’ as the application. Fill in
the applicable dialog boxes on the
Spectral Calibration Editor as follows
(clicking ‘0OK’ when complete to save):
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Casework Analytical Methods:
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Sample Name: date_Spectral

Priority: May optionally be changed to a
number <100 for injection priocrity.

Instrument Protoccl 1l: Choose the
Spectral instrument protocol from the
drop down menu

PowerPlex 16 HS specific run dule and
protocol settings for Spectgﬁ
Calibrations are as ﬁoll
%Q

Module Type: . Spectral
Template: 'Sb Spect36 POP4
Inj. kV: <>
Data Delay Tlm%ﬁsb lOO

bO

Run Time (se 800

Protocol e- @ Q/ Spectral

DyeSeth \Q \) F
Array &, 36
EN C) Matrix Standard

11% @ n bound: 4.0
,&:mn bound: 12.0

I ’\S ég?'S

& o

o) sample plate £ill out the 3130 Load
t {Form 216-BI) on the ‘3130 Load

eat’ tab of the Excel
spreadsheet/template. Print a copy for
the case record. Choosge the ‘3130 Plate
Template’ tab and ensure the information
corregponds to the Load Sheet information
entered. Verify the information on the
template is as follows:

Container Type: 96-Well

Application Type: regular

GeneMapper: GeneMapper Generic Instance
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Sample Name:

Allelic Ladder: LADDER (or PP16_LADDER)

Controls: POS [or (+), etec.], NEG [or (-
y, ete.], BRB (blcood reagent
blank}, SPRB (sperm reagent
blank)}, ECREB (e-cell reagent
blank}, etc.

Case Samples: XY99999999 zZ, . where:
X= Specimen Type { estioned;
V=Victim; S=Susp ;
E=Eliminationkg§§Mother;
F=Alleged Fﬁgﬁ ; C=Child;

FB=Paterna cle; F8=Paternal

Aunt; FM=s ernal Grandmother;
FF=Pate Qggndfather ete.)
R% §:§b ab (M, C or P)
999%8999 ase Number
= %' and letterg that
6}81 se Item (including

erm cell and 'EC' for
<§§;ﬁ cell at end of number
Q§bb d:) neate fraction).

<</(<é
: May optionally be changed to a
r <100 for injection priority.

VM20010112 1AEC)

é‘
io

Glmple Type: Sample Categories of
‘Sample’, ‘Allelic Ladder’, ‘Positive

Control’, or ‘Negative Control’, may
optionally be typed in.

Results Group 1l: Enter the appropriate
results group. These are typically
denoted by the analyst initials and
should automatically populate from the
Load Sheet.

Instrument Protocol 1: Enter the
appropriate instrument protocol (i.e.,
PP16 5 sec, PPl6_3 sec, PPl6_10 sec).
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PowexrPlex 16 specific run module and
protocol settings for sample plates are
as follows:

Module Type: Regular
Template: HIDFragmentAnalysis36 POP4
Inj. kV: 3

Run Time (seconds) :2000

Protocol Type: Regular
DyeSet: F ng

Inj.8ecs: 3-10

3 secs - Allelic Lad@drs and lng POS
control injection times may
be adjus ed@—lo seconds per

JQQ C@L otgation} but a 3
i or sgingle-source
&?@hple@e {mated at 2 1ng

en oduce good results).
5 secs<2 i;& ing generally produce
d EB 1t

4.1.2.3 D t \g’xy% sed wells. Perform a ‘Save
\(\ \ late Template Worksheet to
€§> dl@& USB drive) for subsequent
\\( to the ABI 3130. The document

\:§}m e saved as a .txt file (tab
mited)
(&

(Q 4.1.2.4 Import the previously sgsaved plate record by
{$> selecting ‘Import’ on the ‘Plate Manager’
<2 window. Browge to locate the gaved .txt
file and chooge ‘0OK’.

4.1.2.5 Open the imported plate record by
highlighting it and clicking ‘Edit’.
Review the information in the GeneMapper
Plate Editor to ensure that it is correct
or make changes as necessary. Click ‘OK’
when complete to save the plate record.

4,1,2.6 To perform more than one run of a sample
(e.g. multiple injection times) select
Edit/Add/Sample Run in the GeneMapper
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Plate Editor window. This will add
additional Results Group and Instrument
Protocol columng to the end of the plate
record. These additional runs may be
added at any point in the run, priocr to
the last injection, if the scientist
notices that a sample would benefit from
re-injection (e.g., repeat because of bad
injection or to vary injection times
[from 3-10 seconds}). Additional Results
Groupe and Instrument Protoc may also
be filled in on the origingg) oad Sheet
template prior to import&\

4.1.3 In the manual control window ci%e scientist may
choose to set the oven to C%lso that it will be
ready to run. Choose Ov in,the ‘8end Defined
Command for’ drop down*ﬂ <§Sﬁ In the ‘Command
Name’ box, choose Tu ?igb

ic

‘Value’ of On, and
in the ‘Command
temperature, &b of 60.0 and click
‘Send command%? e the oven has been
ture set, the oven will

turned on
only pre 45<@pnut@s before shutting
1tse1f

4.1.4 Pre;g& 6@3 K%br capillary electrophoresis:

i:§>Fo mpllfled products (including
rolg), typically 1uf-1.5u¢ rxn is
ded to 10pe of ILS Master Mix (made by
(Q adding 0.5uf{ ILS600 size standard/sample;
{$> 9.5n!¢ deionized formamide/sample and
<2 adding guantities for N+2 in Master) that
has been dispensed into the wells of a
pre-labeled plate. For Allelic Ladders
add 1p¢ Ladder to 10u!{ Master Mix. Note:
The master mix may be altered by adding
0.25p¢ ILS600 size to 9.75u¢ deionized
formamide if ILS peaks are toc high.

N

4.1.4.2 Matrix samples are diluted 1:10 in
Nanopure HyO {(a 1:5 dilution may be
necegsary) . 5pi of each matrix dye
fragment is then added to 480u{ of
deionized formamide (without size
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gtandard). Load 25 u! of the fragment
mix into each of four wells on the pre-
labeled plate, which will include each of
the four capillaries (e.g. wells Al
through D1} .

4.1.5 Following sample addition, place a plate septa on
the plate and heat denature for ~3 minutes at
95°C. Immediately chill in benchtop cooler {or
on ice) for 23 minutes (perform on all sample
types - ladders, matrix, controls an qgamples).

Note: the plate septa may be cut t ver only
thoge well columns being used onqékaller plate
runs. CESD

4.1.6 Place the sample plate intg ‘ége plate base and
gsecure the plate retainer{S%&p on top, making
sure that no gray is v%sg le ough the holes.

4.1.7 Place the plate assgab Y. g?

close the doors late
View’ window, \Q@:‘ K&

yellow when th }
detected by

lnstrument and
on the ‘Plate
duler’ will turn
place and has been

r .
\’08
4.1.8 Prior to nni t%g? late, confirm that dye set
a £

F is e correct active calibration

for d¥¢ s E$> et 1n spectral viewer.
8 \V;

4,1.9 e ate record in the ‘Plate View’
xsglnd8§> Cjzhlghllght it by clicking on it once.
\ ith the\plate record highlighted, click the
(Q plate map to link the plate to that specific
<$> reccrd. The plate map will turn from yellow to
<2 green when it is succesgfully linked. Verify the
correct scheduling of the run in the ‘Run View'
window. Select a run and confirm that the
corresponding wells highlighted in the plate
diagram are correct for that run. Make
adjustments to the plate record if necessary.

4,1.10 Click the green Run Instrument arrow button in
the toolbar to start the run. Monitor
electrophoresis by observing the run, view,
array, or capillaries viewer window. Each
injection {(get of four samples) will take ~45
minutes. Note: to run a duplicate plate record,
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the plate may need to be unlinked prior to
linking the duplicated record. This is done by
highlighting the currently linked plate record
and clicking ‘unlink’.

4.1.11 After completion of the spectral calibration run,
open the ‘8pectral Viewer’ window to evaluate the
spectral and set the active calibration. Confirm
that Dye Set F is selected. Click on individual
wells in the plate diagram to see results for
each of the four capillaries. TFor e
capillary, verify that four peaks afte present in
the spectral profile (upper paneLk that the order
of the peaks are, from left t ht, blue-green-
vellow-red, and that the peg%ﬁ re regular in
appearance. Next verify t four peaks are

present in the raw data (lower pane),
that the order of the from left to
right, red-yellow- greég d that the peak
heighte are above 7 4,000 RFU isg
ideal). 1If all f §§§ s pass, then the
calibration shgz(ﬁ ba§' nd set as the active
calibration.

@ \°
Note: Al r rles mugt pass in order to
accept %ggec 1bratlon A passing
capilleg? §Zm. olored green in the plate
dla di ally, capillary status may be

wéJEhé:) vent Log’ under ‘Instrument
Sgé Qgg <§§9un the spectral calibration as
Q?eces ﬁf) til all four capillaries pass.

%§% 12 After completion of the run finish fllllng out
the 3130/3130x]1 Injection Log {(Form 422B-QC).

4.2 DATA ANALYSIS: GENEMAPPER 1ID (GMID)

4.2.1 Data analysis is NOT performed on the instrument
computers. Transfer the run folder (including
the sample sheet) to an analysis computer using a
portable USB drive. After analysis and review
are complete, a copy of the run folder and GMID
project (g) for each case will be stored on the
ISPFS network drive. The Run Feolder on the
instrument computer may be deleted at this point.
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Cage-gpecific CDg will be made for discovery upon
request.

Note: prior to data analysis, the appropriate
panels and bins must be imported into GeneMapperQ
ID. Additionally, previously run 310 Macintosh
data must first be converted to PC files using
the ‘Mac to Win’ conversion program.

4,2.2 Set up the analysis methods for GMID analysis as
follows (analysis methods are create nd stored
in the ‘Analysis Methods’ tab in ngeMapper

Manager’) : \

‘General’Tab: Name the anal‘ié method so that it
reflects what the method 1&6 3130PP16~
15CGRFU) .

‘Allele’ Tab: Choose iz§§g iate bin set.
Chooge ‘Use marker- de01 1 ter ratio if
available’, and re Qﬁln tutter distances’
are from 3 25 2?(3 aé' ra and from 4.25 to
5.75 for pent i%v should be 0.

‘Peak DEQ%) r' vanced Peak Detection
Algorit %§§?zlng (80-550 coxr 600), light
t

smoot hern size calling method

wit ‘&seé@q ow of 51 pts, min. peak half
Qg}ﬁomlal degree = 3, peak window
e \a§1‘5 2

slope thresholds = 0.
\. naly81éC}ange may be set to either full or
(Q partial and is empirically determined for each
<$> run and/or instrument. When using partial range,
<2 the start and stop points are determined by a
review of the raw data and choosing points that

will not include the primer peaks but will cover
the size range of 80 to 2500 bases.

Peak Amplitude Thresholds will depend on sample
quality. Generally 150 rfu threshold in all
colors. Rfu threshold may be raised in Blue,
Green and Yellow for Allelic Ladders. Rfu
threshold may be lowered to 50 rfu at the
analyst's discretion {see 4.3.2 RFU Threshold).
Lowering of rfu threshold below 70 rfu {(to 250)
should be done with caution and only if the data
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generally appears to be good, and without
excessive baseline background or artifacts.
Peaks below 50 rfu are deemed inconclusive.

‘Peak Quality’ Tab: The minimum peak height ratio
for Heterozygote Balance should be set at 0.7.
Set the max peak width to 1.5 bp and pull-up
ratio to 0.05. The signal level and allele
number may be set according to analyst preference
and sample type.

9

‘Quality Flage’ Tab: The guality fggég are only
uged as a tool to aid in data an gis and review
(i.e. to agsist in calling att ion to potential
artifacts or data quality co ns). These flag
settings may be adjusted ac ding to analyst

preference and sample quﬂégty

4.2.3 Create and store a s1 t(;&@gr for GMID
analysis, under the @Slz rds’ tab in
‘GeneMapper Manag ggé size standard so
that it reflec E§~ ndard ig {(e.g.
ILS600 BO- 600&5

Data anal erformed uging the ‘Basic
or Ad €§§? ndard. The gize standard
con81 wmng peaks: 60, 80, 100,

120 égkO , 200, 225, 250, 275, 300, 325,
25, 450, 475, 500, 550, and 600
00 peaks may be optionally defined

Q?y tﬂggié%z}st)

@

%ﬁ@. Create a GeneMapper ID Project:

<2K 4,2.4.1 From the GMID main menu, select File/Add
Samples to project. Highlight the
appropriate run folder in the pop-up
window and click ‘Add to List’, Once the
run folder has been copied to the column
on the right, click ‘Add’ to populate the
project with the samples in the run
folder,

4.2.4.2 In the Samples table, for each sample,
select the gample type, analysis method,
panel, and gize standard from the pull-
down lists. Ladders must be assigned the
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4.2.4.3

4,2.4.4 Analyz \e QQpl

4.2.5 Evaia& e

N

Q‘OQ

4.2.5.2

Casework Analytical Methods:
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sample type of ‘Allelic Ladder’ for the
analysis to occur. In order to use the
control concordance quality flag, all
controls must be marked appropriately as
either ‘Positive Control’, or ‘Negative
Control’. All others may be marked as
‘Sample’ .

Save the project as the case # (and any
other descriptors that may be necessary).
A separate project should be eated for
individual cases. To do t , highlight
the samples not associat with the
particular case and c Edit/Delete
from the project mai nu. Optionally,
samples may be add o the project
individually, ra an the entire run
folder. Note: ﬁ \gyzed project will
be exported Qg older at the

completion @ anﬁi)sQ eview.

by clicking the green
the project has not
-c’— a prompt will appear
ject name before analysis

Anal

@h xv\/ r  ID Data:

4& 6(\? aw Data may be reviewed to determine

ysis start/stop points, or to

entify baseline problems, off-scale
data, excegglve 'gpikes' or other
ancmalies that may interfere with data
analysis and require re-injection or
other corrective measures. Expand the
run folder located in the navigation pane
on the left. Highlight the sample(s) of
interest to view the associated sample
information, raw data and EPT data.
Minimize or highlight the run folder to:
return to the main project window.

Check the 'SQ’ (sizing quality) for all
gamples. A‘green gguare indicates that
the sample has passed the sizing criteria
and need not be manually examined.
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Examine the size standard of each sample
with yvellow and/or red '‘SQ‘ to confirm
correct assignment of fragment sizes.
Highlight the sample(s) of interest and
c¢lick the Size Match Editor button. If
necegsary, adjust the peak assignments by
right clicking on a peak and deleting,
adding, and/or changing values. If all
peaks are correctly labeled but the
gquality score is below 1.0 (may be
checked by choosing Tools/Ch Sizing
Quality), click the ‘Override SQ’ button
to get the SQ to 1.0, if gired. Once
all edits have been mq%éb click ‘OK’ to
save the changes and se the Size Match
Editor (clicking <§y’ saves the

changeg but leawv he, Size Match Editor
open). These <§re ready for
reanalysis i €§e§5 window.

Note: bQSﬁay é}i § deemed acceptable

w1thou d/cr 600 bp peaks
ese onal peaks are
asgﬁ?@é of bleed-through of TMR
é§i> y Amelogenin peaks), the
CS %Q V4 choose an Analysis Method,
reaged rfu thresheld for the

e§} éfbc a el to prevent these peaks from
<§9 etected, if desired.
,& 2. SQ &nae the blue, green, and yellow

lelic ladders. Check that correct
(Q allelic assignments were made.

©

<2 Note: GMID automatically averages all
valid ladders in a run for genotyping.
Genotypes are assigned by comparing the
sizing of unknown alleles from samples
with the sgizing of known alleles
contained within the averaged allelic
ladders of each locus. A ladder(s) may
be omitted from analysis by deleting it
from the main project window prior to
analysis.

4.2.5.4 Data may be examined in various
combinations of colors and/or tables to
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identify bleed-through, spikes, stutter,
-A, off-ladder variants, etc. Sample
Plots viewed from the ‘Samples’
tab/window, allows all loci in a given
color(s} to be viewed simultaneocusly.
The Sample Plots view from the
‘Genotypes’ tab/window; however, allows
loci to be viewed individually {(mcre than
one locus can be viewed at the same time
by adjusgting the number of panes
displayed). ng
WO
4.2.5.5 GeneMapper ID includes ‘geries of
quality flags (PQVs) qia ert the analyst
of potential sample, ity concerns. A
green sguare indic £e¢ that sample data
has passed all o <§% uwality checks, but
yellow or red i gsgthat the data has
a problem wi re of the guality
checks. A flag does not
necessarmégb @)th he data is bad or
unusab §§s are not to be
rell 1 The analysgt may choose
égkg in combination with
\é;&. amination to aid in the
ntx\ on of bleed-through, spikes,
1adder variants, -A, etc.

ég} o) QQé data has been evaluated and
\\ em cceptable, the analyst may choose

\:§> erride the yellow or red Genotype
xé\ éﬁ%ﬂlty (GQ} flag by right clicking on
X flag in the Genotypes Sample Plots

view. Note: overriding the GQ flag will

{F§Q cause all other flags to turn from the
<2 original color to gray.

4.2.5.6 All negative controls {(including reagent
blanks) should be examined to verify that
each displays a relatively flat baseline
in blue, green and yellow.

4.2.5.7 Review all samples (including positive
controls) for the above listed
‘artifacts’ and evaluate: peak height and
shape, matrix/spectral guality, and
individual sample profiles. Cocmpare each
gample with the allelic ladder{s) and

Revigion 12
Casework Analytical Methods: BI-210 5/23/12
Page 87 of 105 Igsuing Authority: Quality Manager




examine for off-ladder or microvariants,
signals that were too low to be genotyped
and assignment of genotypesg to stutter
peaks (or minor peaks that may have been
gsubtracted as 'stutter', etc.

4.2.5.8 Reanalyze individual samples with
different Analysis Methods, as necessary
if the rfu cut-off will need to be
changed.

4,2.5.9 Edit peaks as necessary, tﬁ\ ght
clicking on the peak lab and selectlng
‘add allele’, ‘delete gele’ or ‘rename
allele’. The allele ld be labeled,
at minimum with th lele call, however
the analyst may ct, up to four allele
labels, includ%§351e§§\he1ght and gize,

from the ‘P1 ditor’ window.

Note: label tifact peaks,
such as etc will appear
in the ﬁhot <§§§ie as an additional
allel

4,2.5.10 e ratlng an off-ladder (<

or largest ladder allele,
, tri-allele, or
ant (alleles with incomplete
allele g) should be re-analyzed
\:§> erification where necessary (e.g.,
entiary profile in no-suspect case).
crovariants will be labeled and
(Q reported as "X.¥" (where X is the number
<$> of complete repeats and Y is the number
<2 of base pairs of the incomplete repeat).
Off-ladder will be reported as » or < the
largest or smallest ladder allele,
regpectively. Note: the nomenclature for
upload to NDIS may necessitate a change
in allele designation.

@

4.2.5.11 GMID automatically flags off-scale
{camera gaturation) data. This data may
gtill be acceptable if it is limited to a
few or a single peak and the overall data
for that sample is of good guality (see
4.3.2.4).
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4,2.5.12 Export an allele/genotypes table to
Excel and gave it in the run folder. The
table will be printed for the case file.
The table may also be exported as a .cmf
file for CODIS import. To create a .cmf
file, the specimen category must be
assigned and the export fields set in the
‘CODIS Export Manager’ under tools in the
main menu.

9

4.2.5.13 Print the ‘Samples Plots’-for case
fileg. Only one of the }§elic ladders
need be printed for dq%gabntation

urpogegs.

4,3 STR INTERPRETATION GUIDELINES Q@D @TISTICAL ANALYSES
O

<

4.3.1 CONTROLS Qb

4.3.1.1 The fg%se{g& §éEAGENT BLANK (RB) 1is
&i? he reagents used for
lsolation were
wmth human DNA and as a
monltorlng facility
atlon In GeneMapper , ID
ove thresheld should only
in the CXR (red dye) 1ane

C)g andard. Electropherograms for the

é} blue, green and yellow dyes should show
(Q a relatively flat baseline throughout
<$> the range {(discounting primer signal,
<2 fluorescent 'spikes' or CXR bleed-
through). If detectable signal, with

characteristic 'peak' shape is visible
in the electropherogram of a reagent
blank and does not disappear upon re-
injection, results for all associated
gamples may be deemed inconclusive
(close examination at 50 rfu is
performed on all samples to examine for
presence of any alleles seen in the
RB}. Data may be deemed acceptable if
contamination is 'isolated' to the RB.
The reagent blank should be treated the
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4.3.1.2

o
\&5(\

o)

same as the least concentrated DNA
sample within the associated batch, in
terms of volume and amocunt amplified,
injection time/amount, and analysis
threshold. Additicnally, the reagent
blank will be reamplified with samples
from the set if any of the
amplifications conditions are more
gensltive than the original.

The purpose of the POSITIV
AMPLIFICATION CONTROL an DNA
supplied with the PPlG kit) is to
asgess the amplificagﬁzh process,
ensuring that adeg gsample amplified
simultaneously wo produce an

appropriate si Al]l expected

alleles {see @% @_\st be detected,
R:ga rg or all of the
Lol s

using stan
samples aagpc; h amplification
usive. Data may

may be Q§ém gébnc
be dQZ&B eXe e if all alleles are
pre e }é$§g §EI ome are below 150-rfu

he other positive
actlon Control) appears as

xp%& . the problem is confined
0M sample).

O\/

O
(:\133(\ Q)@GE:NOTYPE LOCUS GENOTYPE
D38 17,18 THO1 6,9.3
<\ Dzlsll€> 29,31.2 D18S51 16,18
C§Q Penta E 7,14 D5S818 12,12
Q D138317 9,11 D78820 8,11
<2 D16S539 9,13 CSF1PO 12,12
Penta D 12,13 AMELOGENIN X,Y
VWA 16,19 D8S1179 14,15
TPOX 11,11 FGA 20,23
4,3.1.3 The purpose of the NEGATIVE

Casework Analytical Metheds:
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BI-210

AMPLIFICATION CONTROL is to determine
if any human DNA contamination occurred
in the process of amplification set-up
(or beyond that point} and as another
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method of monitoring facility
decontamination. In the GeneMapper® ID
electropherogramg, peaks abkove
threshold should only appear in the CXR
(red dye) lane, corresponding tc the
ILS6C0 sgize standard.

Electropherogramg for the blue, green
and yellow dyes should show a
relatively flat baseline throughout the
range {(discounting primer signal,
fluorescent 'spikes' or CX pleed-
through) . If detectable . @ignal, with
characteristic 'peak® pe, 1s visible
in the electropheroqié& of a negative
amplification congiﬁ and does not
disappear upon r jection, xresults

for all of the ples associated with
that amplifi 'on<j§ll be examined for
the presen f AR® s&@e peak (s). It

is possist, ad is control is
ts tube
open during the

proces la ang
delibefate 'Eie
amplific %éﬁh af -up {(to demonstrate
m ¥éfn \&n fnation potential), that
%!s@w\c&u)%d k@ e only sample affected.
O @c égéou X 1y in thi
\Q L% Q g peaks appear only in is
eg} ﬁbn r&8Y, the data for other samples
x?\ (ﬁaéséékfated with that amplification need
@) \:§> be deemed inconclusive. This
XS\ C) currence ghould be documented and the
Qés gcientist's determination {(and basis
C§Q for it) documented in the case file.
<2§' 4.3.1.4 The purpose of an EXTRACTION CONTROL
gample is primarily to assess correct
genotyping, however, it does take
measure of all of the gteps in the
analytical process from extraction
through allele degignation. The
extraction controlsg consist of ~3mm?
cuttings of previously typed
bloodstaing prepared in batches. An
extraction control must be run with
every batch of forensic cases (will
generally be extracted with reference
gsamples or non-semen evidence). The
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reviewing scientist will complete an
Extraction Control Check Form (Form
212-BI) for verifying correct
genotype{s). A copy of this form will
be included in each associated cage
file. Failure of the extraction
control, if isolated to that zample,
will not deem other samples
inconclugive.

4.3.2 RFU THRESHOLD: Q%
O

4,3,2,1 Por reference blood or al standards
{excluding autopsy @ther samples
that may be degrad qqgr of limited
guantity), a mini of 100 rfu should
be achieved for{@ata acceptance. If
necessgary, do the process as
follows: r t ﬁég ion (changing
lnjectlonqglme &Sbeconds allowable
range) éb P ééﬁ—analy51s (i.e.,
chan Q_nt amplified product

adde fo t analysis), or re-
égé qg) increase DNA template),
qb lon.
~¢$3 QSSln mlxture components (or low-

é$> py gle-source forensic samples), a
0ld of 50 rfus may be used (see

\:§> .2 Peak Detection). However,

XS\ pending on signal/baseline may be

\ deemed inconclusive.

{$§Q 4.,3.2.3 Peaks below the analysis threshold

<2 (based on data obtained and
gignal/baseline) will not be
interpreted but should be noted as
being present in the cage notes (eg. on
the table of results).

4.3.2.4 Peaks marked as off-scale in GeneMapper@
ID (indicating camera saturation) will
not be interpreted if multiple peaks
are affected and if it causes excessive
artifacts (i.e. split peaks, increased
stutter, pull-up, etc.) which interfere
with data interpretation {(see
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4.3.2.5

4.2.6.11). If the overall quality of
the data is not acceptable, the sample
must be diluted, re-injected (3-10
secondsg), reanalyzed (decreasgse the
amount of amplified product added) or
re-amplified {decreasge DNA template)
deemed appropriate by the gcientist.

as

Multiplex amplification kits are
degigned so that heterozygous loci in
single-source samples gene 1y
demonstrate relatively bqgg ced peak
heights [typically 270%(peak height
ratio (phr}]. Some les, although
gingle-source, may times demonstrate
greater imbalanc ue to degradation,
gstochastic eff rimer binding site
mutations, l amplification,
etc. Peak g for thege loci

(<70% p §?w11i3$? ﬁéﬁgged in

GeneMa

4,3.3 EXTRA PEAKS ( ON&Q @}é

Casework Analytical Methods:
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q@'%%eak
0
s minor peak 1ls referred to as the

O

BI-210

tlon of STR loci typically

%igynunor product peak one core
t shorter than the main

(n-4 for tetranucleotide

nd n-5 for pentanucleotide loci).

utter peak. Percent stutter
generally increases with allele length
and does not change significantly with
the quantity of input DNA (peak heights
within ~150-4500 RFU). The measurement
of percent stutter may be unnaturally
high for main peaks that are off-scale
or due to problems with spectral
performance and can be corrected by
diluting (or reamplifying less DNA) the
gample and/or applying a new spectral.
Loci stutter values are listed in
Appendix A to assess potential
contribution tc peaks in stutter
positions.
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4.3.3.2 Electronic or fluorescent spikes are
random events that produce generally
spike-shaped peaks in most or all dye
colorg at the same location (equivalent
bp size) within a single injection.
Peak heights usually wvary between dye
colors for a given spike. These
anomalies are generally not
reproducible and will typically be
eliminated upon reiniection. If the
spike is above the analysig“Bhreshold
and falls within an alle‘igbrange that
could interfere with e er computer
analysis or Scienthggﬁ analysis, the
sclentist w111 lab he spike in the
GeneMapper ID so are so that it

appears on the nted
electrophero <§

4.3.3.3 Dye “blob ar <;ﬁag§é}es that

typica «éb i e same approximate
loca ﬁh& e injections and do
not _alwa i ear upon reinjection.
B &g% égi> look like broad or
@e@sr Q g and may occur in a
qgin or or multiple colors at the
Y}» ximate location but can vary
&(} t. The blob should be labeled
Q:mé{ electropherogram {in GMID) if it

\:§> s within a diagnostic region and is
~§ gignificant size to potentially

QS' 1nterfere with analysis.

R

{$§Q 4,3.3.4 Bleed-through or pull-up peaks are a

<2 result of the gpectral not correcting
for all of the spectral overlap (most
common with the PowerPlex 16 HS kit
from yelliow into red) and may be
increased due to off-scale peaks.
These pull-up peaks are in the same
location (same bp size) as peaks in
another color(s) and are easily
recognized. The presence of bleed-
through should be labeled on the
corresponding electropherogram (in
GMID} 1if it falls within a diagnostic
region and is of significant size to
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potentially interfere with analysis.

If excessive bleed-through occurs in a
color other than red, and is not due to
off-scale data, a new gpectral may need
to be performed.

4.3.3.5 Tag Polymerase can catalyze the
addition of a single nucleoctide
(predominantly adenosine) to the 3¢
ends of double gtranded PCR product,
resulting in product one zgéb pair
longer than the actual t t sequence
(+A). Amplification p meters include
a final extension tig%Z’so that the
reaction is drlven full A addition

(i.e. all product,3s +A) Split-peaks
may occur asg a 1ncomp1ete A
addition and ‘gs single allele
represente one base pair
apart (- can occur when
the am ofqg e DNA is too great
(ove 65 ed(~ . In this instance,
Taq add the A nucleotide
to\V e ount of product
qgéQ he time allotted. These
am Q@r typically contain off-
O ags well. Split peaks can be

X : : 5
Qo) vigted by incubating samples at 60°C
\6 0&2 Q\( additional 45 wminutes, followed
\:§> ilution prior to reinjection. It
y be necessary to re-amplify the
C)Sample with less template DNA.

N
%)
S

<2 4.3.4 MIXTURES

4.3.4.1 If, after the elimination of possible
stutter and/or bleed-through, a profile
showg at least 3 peaks at 2 or more
loci, thisg is strong evidence of a
mixture.

4.3.4.2 Loci that demonstrate only two alleles
but have a heterozygous ratio of <70%
may alsgso be indicative of a mixture.
However, if data are obtained from
multiple loci, a sgscientist should
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403‘403

4.3.4.4

expect to see this or other mixture
indicationg (> 2 alleles) at additional
loci.

Mixture assessment, in terms of
determining the presence of a mixture
(# of potential contributors) and
probable locus genotypes is performed
prior to examining the reference
profiles.

9

In a probable 2-person mi re (no more
than 4 alleles at any given locus) it
may be possible to q%sérmine a major
versus minor contrij or at some or all
loci. A major p le is one in which
a distinct pr nt DNA profile is
present (as %sgsam ‘gd by number of
peaks, rel <2 elghts, and peak
balance . trlbutor ig the

less pr &proflle in the
mixtyxé) \
R \Q)

4.3.4. QZOCE\ h dlStlnCt major/minor
qiéﬁ e digcernible (this will
in a mix of more than two

s' DNA), both genotypes may

E}(b o@ ”\/ red-

S 308

S 7O

Q‘OQ

4.3.4.7
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<g§yen that heterozygous peak ratios are
t

100% (complete balance), caution
must be exercised in determining
"shared alleleg", ag a scientist does
not know (a priori) which allele of a
heterozygous individual may be
predominant (i.e., the "highest rfu
peak” in the 3-peak mixture may not be
the shared allele}). Calculations to
determine the relative peak height
ratiogs of 3-peak loci may be performed
to asgist in this determination (see
Appendix B for calculation examples).

For samples where distinct genotypes
are discernable, ‘gingle-source’
statistics are calculated for the
individual profile{s) in the event of a
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profile match. It is more common;
however, to only report a distinct
major profile, due to the possibility
of shared and/or dropped-out alleles in
a minor component. Caution should be
exercised when reporting a distinct
minor profile for a sample.

4.3.4.8 Minor contributors in which a distinct
minor genotype cannot clearly be
determined will be reported@s an
inclusion/cannot be excluded (all minor
alleles in the sample ounted for) or
an exclusion {all o qgagorlty of the
m

minor alleleg in t ple not
accounted for) an tatlstlcs will not

be calculated £ hat minor
contributor, {é’e‘@assible that an
individual ﬁ@ D) e&éxcluded as a
posgible r 32% the minor
compone me of the
refe ;:§§%ay not be present,
Thls oul&V with low level DNA and
Oqg;g indication of posgsible
mb@ Qﬁ@l% ontributors to a mixture
Q} Qh stinct genotypes cannot be
ined and/or mixtures of more than

0$\ 0(\ é}‘@ individuals will be reported as

clusions (all reference sgample

Q§§' ()alleles present in the mixture}, cannot
(Q be excluded (majority of reference
{$> alleles present in the mixture but may
<2 be low level and have some indication
of allele drop-out), or exclusions

{(majority or all of reference alleles
not present in the mixture) .
Statistical interpretation will
demonstrate the significance {(or lack
thereof} of the data.

4.3.4.10A sample with interpretable peaks at
one or more loci may be reported even
1f no peaks are detected at additional
loci (i.e. partial profiles);
statistical interpretation will
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demongtrate the gignificance (or lack
thereof) of the data.

4.3.5 STRg: STATISTICAL GUIDELINES

To present the gignificance of a match between STR
profiles, the scientist uses the population
distribution (frequency) of alleles at the various loci
examined to assess how likely it is that this match
might occur by chance. This general concept forms the
basgsis of all calculations used in the xepoegbng of
forensic "matches”. .
Y
4,3.5.1 The freguency of ocqg) nce of a STR
profile cbtained fx an evidentiary

sample will be determined by
examination of freguency in the
FBI's Cauca51aéb %sgcan American and

Hispanic dagéa izg) alculatlons will

be perfor ugg <g§s Popstats and/or
DNAV:Lew\b ogr ditional

popu n \ﬁ also be used when
avai blexgﬁ evant to a particular
ca&@b éé>B«;é:b QA Manual, section
% \é}n orting of statistical

re q%i
8¢§>2 @ﬁ fééquency for a heterozygous

e ig determined by the equation

\)(\ @) = 2pqg.

{SA 4,3.5 g)The frequency for a homozygous profile

(Q is determined by the equation fip = p?
<$> +p(l-p}6, where 8 = 0.01 except where
<2 small isclated populaticns (e.g.,

Native Americans) may be relevant, in
which case, 0=0.03.

4.3.5.4 For single-scurce evidentiary samples
(or mixtures for which a distinct
genotype (8} 1g discernible) the
statistical consideration will be in
the form of a RANDOM MATCH PROBABILITY
(RMP; or inverse probability of
inclusiocn). The RMP is the inverse of
the calculated profile frequency (e.g.,
for fism profile) = 2 X 107, RMP= 1 in 5 x

Revigion 12
Casework Analytical Methods: BI-210 5/23/12
Page 98 of 1065 Issuing Authority: Quality Managexr




4.3,5.5

e§§\

{>
@o

Q‘OQ

Cagework Analvtical Methods:
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10, see Biology QA Manual, section
11.3.6 for reporting of statistical
frequencies) .

For mixtures for which distinct
genotypes are not discernible, and one
or more of the associated reference
samples are included in the mixture,
the scientist wmay elect to use either
the LIKELIHOOD RATIO (LR}, PROBABILITY
OF EXCLUSION (CPE}, or PROE&BILITY OF
INCLUSION (CPI). \SS)

The LR compares the %'\bability of the
occurrence of the entiary profile
under two hypothqégg regarding the
composition of profile and ig in

the form: QO OQ
LR = evgﬁentQ ,&@R profile|H;)
@de&\ a&i’R profile|H,)

The f% , the more likely Hy
pothesgis (See Biology QA

N@% on 11.3.6 for reporting of
(gta &1 frequencieg). For a

calculation, thisg corresponds

Oﬁb \/ (Paternity Index).

<€§9 (Pg) represents the probability

at a randomly selected individual
would possegs one or more alleles
inconsistent with the crime scene stain
{or paternity). It is the complement
of the RANDOM MAN NOT EXCLUDED {or
"inclusion probability®; P;i).

The PE and PI do not take into account
the number of contributors, the
principals' genotypes (i.e., the fact
that they could account for the
profile) or the evidence (e.g., peak
height differences allowing probable
donor assignment}. They are calculated
as follows:

P = 1-P;
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4.3.5.6

Where Pr = (p1 + D2 +Ps ...Px)° (the
square of the sum of the freguencies of
all alleles present in the evidentiary
gsample) . The Picombinea (CPI) may be
calculated by multiplying the P; for
each locus.

The Pgecompinea (for all of the loci
combined/CPE) is as follows:

Pgcombined = 1 — Picombined: OI‘ 'G-P(l' PEI) (1“
Prz) (1- Pga) Pgis) ]
(See Biology QA Manual, ~S§ct10n 11.3.6

for reporting of staesatlcal

frequencies} .

In addition to$ and PE used in
paternity, th ‘Splity of paternity
may be usedQ% glven that this
statistic —genetlc
1nforma éh e prior odds of
pate Lor oddsg used {e.g.,
50%) ho licitly stated (See
Bluszg 1, section 11.3.6 for

%@or g é@tatlstlcal frequenciesg) .

Cagsework Analytical Methods:
Page 100 of 105

2§$ y‘é&ﬁen81c cases, the denominator

MP obtained for an evidentiary
from the analysis of geveral

<§§§ymorphic STR loci, exceeds the

ulation of the world geveral-fold.

owever, no reasonable individual would
make the assertion that every
individual in the world need be
considered a potential DNA source in
the context of a given cage. 'SOURCE
ATTRIBUTION' (see Budowle, B. et al,
Source Attribution of a Forensic DNA
profile. Forensic Science
Communications. 2(3) July 2000} is the
result of a statistical approach to
'operationally' define uniguenesgs
(assess whether a given multi-locus DNA
profile could be considered unique for
a given case) .
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The equation pxﬁl—(l—u)lﬂqwa/N, is used
to determine maximum RMP {px} that would
suppcert 'source attribution' for a
relevant population sample size (N) and
gelected confidence limit (i.e.,

o=0.01; 1-w=99% confidence).

The FBI has selected an upper
confidence limit {(UCL) of 99% {wo=0.01)
and an "N" eqguivalent to the U.S.

population (2.6 x 10° pre- 0 census).
This is reasonable as th I performs
casework for jurisdictioms all over the

country and this caLgébation would
provide a uniform, oach to be used
regardless of jur iﬁiction. For these
figures, an RMP§< .9x10™" (or less
than 1 in 2.6 )<5gmld confer 99%
confldence he e&édentiary profile

is unlque k% ation. However,
an addl na Q

conservatilion
factoxODas _gfaco ded in NRC II, is

add to 8 ure resulfing in a
£ &éhe é§>o ss than 1 in 2.6x10' for
%&@ éﬁ t@g of source attribution.
O 2Nk -
Y}» IQS q§$a uging 2000 consensus flgures,7
e§} an Qgé tional population (N} of 1.6x10
5\\ OOnaG en selected (representing the sum
@) \:§> the populations of Idaho and the six
rrounding states: ID=1.3x10°%;
@K MT=0.9x10°; NV=2.0x10°; OR=3.4x10°%;
Q UT=2.2x10°%; WA=5.9x10° and WY=4.9x10%).
<$> Therefore, an RMP of less than 1 in
<2 1.6x10*° (including 10-fold
conservation) will define source
attribution (at 99% UCL) for analyses
pexrformed in this laboratory (See
Biclogy QA Manual, section 11.3.6 for
reporting of statistical frequencies).

5.0 Comments:

5.1 The 3130 Data Collection Software does not allow the
entry of spaces or dashes in titleg, sample names,
etc. An underscore must be usged in place of spaces
when entering information.
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BI-400

DRIFTCON FFC: TEMPERATURE VERIFICATION

1.0 BACKGRCUND:

Successful DNA amplification is dependent on consistent
thermal cycling parameters and achieving proper heating and
cooling to facilitate the various steps necessa for PCR.
It is necegsary to employ a method of monitoriqgg?he thermal
cycler performance and verify that the corre temperature
has been achieved in corder to have confid in the
amplification process. A variety of tem ature probes have
been developed to test the temperatur@'éé gpecific wells
within the different thermal cycler i ruments. However,
mogt of these have proven to be cu time consuming,
and not amenable to testing the (3 Lx&ime PCR
instruments. The Driftcon FFC 48 agég) q€&est multiple

temperatures within a short Qh (@g and can be used on
the thermal cyclers, as we I) instruments.

Driftcon Operations Manu@ﬁ *é?s%s§:i

Driftcon Quick Startthldégb s on 1.4

2.0 SCOPE: ) <§$
oY O

Tc provide §:§§% od for verifying the performance of

laborator herm erg, to include real-time PCR
instrume

3.0 EQUIRQ§%T/REAGENTS.
X

Computexr with Driftcon Software
Driftcon Hardware Module and Cables
Driftcon FFC Fixture

Driftcon Smart Card

ABI 7500 FFC Adaptor

Cork Leveler
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4,0 PROCEDURE:

4.1 9700 THERMAL CYCLER VERIFICATION

4.1.1

Set up the Driftcon by connecting the hardware
module to the computer and FFC fixture/probe plate
with the provided cables.

Insert the smart card into the Drifte hardware
module until it stops. ~SS>

Turn on the Driftcon computer. ~@pén the Driftcon
Software and login with the aeg prlate user name
and password.

Turn on the 9700, place ure into the plate

with the cable facing ect/start the

‘Driftcon’ protocol the 9700 lid as
c?\

it will damage thaQ\ xtu a 01d the warranty.

In the Drlftcon oose the instrument to

be tested. instruments does not

appear au q%b&y 1lck start and follow the

wizard pro ts%

Choigsﬁgie default protocol and make sure
ep hose in the 9700 protocol. Leave

1t pressur@, and temperature blank.

~3?ter s needed (these will appear on the
BN

Q{QQ7

nal re

Start the test by clicking the check mark in the
lower right corner. Make sure the 9700 has heated
completely and the protocol started before
starting the test. The protocol will complete in
~25 min.

Once the run has completed, print the report and
place it in the QC binder.

4.2 7500 REAL-TIME INSTRUMENT VERIFICATION

4.2.1

Set up the Driftcon by connecting the hardware
module to the computer and FFC fixture/probe plate
with the provided cables.
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4,2,2 Insert the smart card into the Driftcon hardware
module until it stops.

4.2.3 Turn on the Driftcon computer. Open the Driftcon
Software and login with the appropriate user name
and password.

4.2.4 Turn on the 7500 computer, login with the
appropriate user name and password, and open the
7500 SDS software. ®6

O
4.2.5 Turn on the 7500. Remove the tr%§§%rom the plate
loader and replace it with thec%h adaptor. Place
the fixture into the adaptor 1 the cable facing
out. Place the cork levelea9 top of the fixture
and close the plate 1oadeé§>

4.2.6 In the 7500 SDS softw @&sa&ixle > New and

select Abgolute Qua a i sgay, 96-Well
Clear for Contain {S)an on for Template.

4,2.7 Save the plate %cum& §>a .8ds file with the

approprlate cpen the Instrument
tab. %}
4.2.8 In the Q} ware, chooge the instrument to
(} f list of instruments does not
ap§ ally, click start and follow the

4.2 sQhocme t@ Driftcon default protocol and make sure
{Q the steps match those in the 7500 protocol. Leave
{SD the humidity, pressure, and temperature blank,
<2 Enter notes as needed (these will appear on the
final report).

4,2,108tart the 7500 xrun and Driftcon test. Start the
test by clicking the check mark in the lower right
corner. Make sure the 7500 has heated completely
and the protocol started before starting the test.
The protocol will complete in ~25 min.

4,.2,110nce the run has completed, print the report and
place it in the QC binder.
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5.0 Comments

5.1 The second page of the report contains information

regarding the number of measurements for each probe.
The number should be approximately double the protocol
time. If significantly higher or lower, the
instrument may be heating too slowly or too gquickly.
The percentage should be 100% forxr each probe., If a
percentage is lower than 100%, the probe may not have
been in the well and measurements missed. Adjust the
probes and run the protocol again. ng

5.2 Pass/better than specifications/fail c')for each
temperature may be found beginning erflpage four of the
report. The measured wvalue, alon g?th the target
gspecificationg are shown in thi§é§éction.
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